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1 About This Book

1.1 Audience
This book is written for developers who want to develop new Web applications or deploy
their existing Sybase® PowerBuilder® applications to the Web with Appeon® for
PowerBuilder®.

1.2 How to use this book
There are seven chapters in this book.

Chapter 1: About This Book

A general description of this book.

Chapter 2: Web RAD with PowerBuilder and Appeon

Introduces rapid Web application development using PowerBuilder and Appeon for
PowerBuilder.

Chapter 3: Migration Process

Describes the methodology of Web conversion based on an existing PowerBuilder
application.

Chapter 4: Migration FAQ

Frequently asked questions and answers regarding the deployment of PowerBuilder
applications to the Web with Appeon for PowerBuilder.

Chapter 5: Building and Migrating Distributed Applications

Specific instructions for the Web migration of distributed applications.

Chapter 6: Enhancing an application with Web or Appeon features

Describes the key enhancement features that you can add in the PowerBuilder application to
make them effective in the deployed application.

Chapter 7: Migration Tutorial

Walks you through the entire process of deploying a small PowerBuilder application to the
Web.

1.3 Related documents
Appeon provides the following user documents to assist you in understanding Appeon for
PowerBuilder and its capabilities:

• Introduction to Appeon:

Gives general introduction to Appeon for PowerBuilder and its editions.

• Getting Started (for Appeon Mobile):

Guides you though installing PowerBuilder and Appeon for PowerBuilder, and developing
and deploying a mobile application.
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• New Features Guide:

Introduces new features and changes in Appeon for PowerBuilder.

• Appeon Mobile Tutorials:

Gives instructions on deploying, running, and debugging the mobile application,
distributing native mobile apps, and configuring the Appeon Server cluster.

• Appeon Mobile (Offline) Tutorials:

Gives instructions on setting up the Appeon Mobile (Offline) environment, and
configuring, deploying, running, updating, and debugging the offline application.

• Appeon Installation Guide:

Provides instructions on how to install Appeon for PowerBuilder successfully.

• Installation Guide on Cloud Platform:

Provides instructions on how to install Appeon for PowerBuilder on the cloud-based
platform such as Windows Azure and AWS EC2 and S3.

• Mobile UI Design & Development Guide:

Introduces general guidelines on designing and developing the mobile app and UI.

• Migration Guidelines for Appeon Web:

A process-oriented guide that illustrates the complete diagram of the Appeon Web
migration procedure and various topics related to steps in the procedure, and includes
a tutorial that walks you through the entire process of deploying a small PowerBuilder
application to the Web.

• Supported PB Features:

Provides a detailed list of supported PowerBuilder features which can be converted to the
Web/Mobile with Appeon as well as which features are unsupported.

• Appeon Developer User Guide:

Provides instructions on how to use the Appeon Developer toolbar in Appeon for
PowerBuilder.

• Workarounds & API Guide:

Provides resolutions for unsupported features and various APIs to facilitate you to
implement the features (including Web and mobile) that are not easy or impossible to
implement in the PowerBuilder IDE.

• Appeon Workspace User Guide:

Gives a general introduction on Appeon Workspace and provides detailed instructions on
how to use it.

• Appeon Server Configuration Guide:
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Provides instructions on how to configure Appeon Server Monitor, establish connections
between Appeon Servers and database servers, and configure AEM for maintaining
Appeon Server and the deployed applications.

• Web Server Configuration Guide:

Describes configuration instructions for different types of Web servers to work with the
Appeon Server.

• Troubleshooting Guide:

Provides information on troubleshooting issues; covering topics, such as product
installation, application deployment, AEM, and Appeon application runtime issues.

• Appeon Performance Tuning Guide:

Provides instructions on how to modify a PowerBuilder application to achieve better
performance from its corresponding Web/mobile application.

• Testing Appeon Web Applications with QTP:

Provides instructions on how to test Appeon Web applications with QTP.

1.4 If you need help
If you have any questions about this product or need assistance during the installation
process, access the Technical Support Web site at http://www.appeon.com/support.

http://www.appeon.com/support
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2 Web RAD with PowerBuilder and Appeon
Developers can utilize PowerBuilder and Appeon for PowerBuilder to achieve rapid Web
application development (Web RAD). Web RAD with PowerBuilder and Appeon greatly
reduces the software development life cycle and I.T. development complexity, while
preserving end-user productivity.

2.1 Traditional approach to Web development

In order to write even a small Web application with traditional methods, it takes a great deal
of time, and the resulting Web application usually has an oversimplified user interface. Web
application developers must master various new skills, such as ASP/JSP/PHP, Ruby, Python,
Perl, JavaScript, Ajax, XML, HTML, Java, .NET, and J2EE when using Microsoft or Java
technologies.

2.2 Advantages of Appeon for Web RAD

Using PowerBuilder and Appeon to develop powerful Web applications has the following
advantages:

2.2.1 Provides the fastest path to the Web

Appeon for PowerBuilder achieves unparalleled reductions in project cycle time and costs
by eliminating the traditional Web application design, coding, and testing effort associated
with rewriting applications for the Web. When your objective is to build a new application,
Appeon provides the most productive development approach for building enterprise-class
applications that adhere to the most stringent Web standards.

2.2.2 Provides the best Web GUI possible

Appeon Web applications precisely replicate the desktop application user interface with
HTML running in standard Windows Web browsers. Appeon graphical capabilities make the
end user far more productive than any possible rewrite and eliminates all user-retraining time
and costs.

2.2.3 Minimizes business risks

Appeon for PowerBuilder greatly reduces business risks associated with building new
software applications, because the time-tested PowerBuilder program code and DataWindows
run at the core of the Web application.

2.2.4 Leverages current organizational skills

Appeon for PowerBuilder:

• Relies solely on PowerBuilder skills and IDE to develop and maintain the application.

• Reuses the existing application source code and database, preserves investments in
designing, building and testing the application UI, application business logic, data-access
logic, and the database.
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• Operates upon a single set of native PowerBuilder source code for deployment to both
desktop and Web environments.

2.3 Leveraged functionality with server components
Appeon's support to .NET/COM components enables you to access enhanced Web
functionality. When developing new Web applications with PowerBuilder and Appeon,
you can use the .NET/COM components in Appeon Server as a bridge to access many other
functions on the Web and some Client Server application features that may even transcend
the Web limitations. For detailed description, refer to Section 2.3.8, “Calling .NET/COM
server components (.NET only)” in Workarounds & API Guide.

2.4 Appeon Web RAD methodology
Web RAD (Rapid Application Development) with PowerBuilder and Appeon is for writing a
new PowerBuilder application and converting it to the Web using Appeon for PowerBuilder.

There are three steps in an Appeon Web development project:

Step 1: Analyze the project requirements. According to these requirements, lay out the
function specifications that should be met for the project.

Step 2: Develop a new PowerBuilder application and implement the functions in it with
PowerBuilder programming that conforms to the Appeon PowerBuilder coding standards.

During the coding process, utilize the Code Insight tool in Appeon Developer to make sure
the new code does not contain unsupported features.

While you develop a new PowerBuilder application, keep in mind one of the more
recent and stringent standards, the Section 508 Amendment to the Rehabilitation
Act. Refer to the whitepaper available at http://www.sybase.com/content/1035234/
PB_508_Compliance_wp.pdf for details of the standard.

Step 3: Migrate the PowerBuilder application to the Web with Appeon for PowerBuilder by
following the migration process described in Chapter 3, Migration Process.

Most of the time and effort in Appeon Web RAD methodology is spent working in the
PowerBuilder IDE to code the desktop PowerBuilder application.

2.4.1 Appeon-standard PowerBuilder coding

Appeon PowerBuilder coding standards are recommended ways to write PowerBuilder
code so that it can be recognized and translated into corresponding Web languages (HTML,
JavaScript and XML) by Appeon.

The Appeon PowerBuilder coding standards are laid out in Supported PB Features for
Appeon Web (Web only). When coding the new PowerBuilder application, you should refer
to this document to ensure the Appeon PowerBuilder coding standards are followed.

After writing the new PowerBuilder application, use the Appeon Developer toolbar integrated
into the PowerBuilder IDE to automatically convert the PowerBuilder application to the Web.
Some further modifications to the PowerBuilder application may be needed in order to make
the application fully functional. Finally, convert the PowerBuilder application and deploy the
Web application to servers for production use. For detailed instructions on Web deployment,
refer to Chapter 6, Deploying PowerBuilder Applications in Appeon Developer User Guide.

http://www.sybase.com/content/1035234/PB_508_Compliance_wp.pdf
http://www.sybase.com/content/1035234/PB_508_Compliance_wp.pdf
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3 Migration Process

3.1 Introduction

Instead of providing detailed instructions on each step, this chapter emphasizes the overall
process. Each section may reference other places within this document or other Appeon
documents and support information.

If your goal is to write a completely new PowerBuilder application and deploy it to the
Web, first refer to Chapter 2, Web RAD with PowerBuilder and Appeon, and then refer to
instructions in this chapter for migrating the new PowerBuilder application to the Web.

The following figure illustrates the general process of deploying an existing PowerBuilder
application to the Web. The process is divided into two phases:

• Phase One: Planning - Evaluating strategies for your Web migration objective.

Step 1: Install required software

Step 2: Understand the general limitations of the Appeon solution

Step 3: Define migration objective

• Phase Two: Implementation - Implementing your Web migration objective.

Step 4: Upgrade the original PowerBuilder application

Step 5: Prepare the target PowerBuilder application

Step 6: Pre-configure for Web application

Step 7: Remove or workaround unsupported features

Step 8: Enhance the application with Web or Appeon features

Step 9: Trial deployments

Step 10: Debug Web application

Step 11: Performance fine-tune

Step 12: Go-live deployment

Step 13: Go live
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Figure 3.1: Appeon Web Migration Process

3.2 Installing required softwares

The first step in the Web migration process is to set up the software environment.

Figure 3.2: Appeon for PowerBuilder works in a standard n-Tier Web architecture

The following softwares should be installed to support the architecture:
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• Windows Server 2008 SP2, Windows Server 2008 R2, Windows Server 2012, Windows 7,
or Windows 8/8.1

• Microsoft Internet Explorer 8.0 or above, Google Chrome, Mozilla FireFox, or Opera

• SAP Sybase PowerBuilder

• Database that your application uses

• Application Server (any of the following types):

• SAP Sybase EAServer

• Microsoft .NET Framework & Microsoft IIS

• Oracle WebLogic

• IBM WebSphere

• TmaxSoft JEUS

• JBoss

• Appeon for PowerBuilder, which includes:

• Appeon Server (Which includes Appeon Enterprise Manager, Appeon Server Status
Monitor, and Appeon Server Web Component)

• Appeon Developer (Windows only)

• Appeon Server Web Component

• Appeon Help (Windows only)

• SAP Sybase EAServer (Only provided in Appeon for EAServer editions)

For detailed instructions on installing the required softwares, refer to Installation Guide
for .NET.

3.3 Understanding the general limitations of the Appeon solution

There are some general limitations in the migration capabilities of Appeon for PowerBuilder.
These limitations affect how well a PowerBuilder application is suited for Web migration
with Appeon. It is very important to be aware of these limitations in advance.

Table 3.1: Limitations of the Appeon solution

Limitation What it limits... Try to work around the limit by...

Coding style Appeon recommends not using
certain coding styles such as
generic code.

Avoiding the coding styles that do
not work well with Appeon based on
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Limitation What it limits... Try to work around the limit by...
advices in Supported PB Features for
Appeon Web (Web only).

Database Appeon for PowerBuilder
supports the following database
types:

SAP Sybase ASE, SAP Sybase
ASA/SQL Anywhere, SAP
HANA, Microsoft SQL Server,
Oracle, IBM DB2, SAP Sybase
IQ, MySQL, Informix, or
Teradata

For details, see Installation
Guide for .NET.

Always using the supported database
types.

Unsupported
features

The Supported PB Features
for Appeon Web (Web only)
provides a list of supported and
unsupported features.

Working around unsupported
features by following the Chapter 4,
Workarounds for Unsupported
Features in Workarounds & API
Guide.

For more information regarding the limitations, we recommend you read Chapter 2, Basic
Requirements and Recommendations in Supported PB Features for Appeon Web (Web only).

3.4 Defining migration objective
There are three typical migration objectives:

• Convert an existing PowerBuilder application to the Web.

• Extract a portion from an existing PowerBuilder application, such as a set of Windows and
key functions, and migrate that portion to the Web.

• Migrate some DataWindows from the original PowerBuilder application to the Web.

3.4.1 Defining migration objective for non-PFC application

Step 1: Calculate the total size of the PBLs that make up the original PowerBuilder
application.

Step 2: Identify the major unsupported features in the existing PowerBuilder application.

Step 3: Briefly assess the amount of work needed to modify the unsupported features in the
existing PowerBuilder application. The assessment standards are as follows:

• The more complex the PowerBuilder application is, the more difficult it is to modify its
unsupported features. The complexity can be characterized by advanced coding techniques
including deep inheritance, etc.

If there is a large amount of business logic on the Client-side (e.g. in Windows and
behind controls) and the logic is complex (e.g. it fires 20 events before the business rule is
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completed), then your application will most likely benefit from moving the business logic
into n-Tier NVOs. This takes additional work and needs to be factored in.

• The more unsupported features the PowerBuilder application has, the more effort it takes
to modify them.

Section 3.8, “Modifying unsupported features” provides methods on working around
unsupported features.

Step 4: Decide the migration objective:

• If it is imperative that your company move business to the Web quickly, select the first
migration objective and deploy the entire PowerBuilder application to the Web; otherwise
select the second or third migration objective.

• Based on the assessments in the previous step, if substantial effort is required to modify the
unsupported features in the original PowerBuilder application, you may want to consider
converting part of the application to the Web (objective 2). Regardless of the approach
taken, it will always take less work to deploy a PowerBuilder application to the Web
with Appeon than to rewrite it with J2EE/.NET, as PowerBuilder is highly productive,
especially for your PowerBuilder team.

• The third possible objective is to deploy only your application DataWindows to the
Web (separately from the application). This involves building a much smaller new
PowerBuilder application and reusing the existing DataWindows. This is a logical solution
when some key reporting functionality or data needs to be available on the Web in a very
short time and it would otherwise take significant effort to deploy the entire application.

3.4.2 Defining migration objective for PFC application

3.4.2.1 Corporate PFC architecture

The following diagram illustrates the typical architecture for PFC applications.

Figure 3.3: Typical PFC applications architecture

The Corporate Class Library extends the PFC Ancestor Level, and contains customized
and enhanced functionality for reuse by various applications within the entire corporate
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class library. The PFC Extension Level PBLs are included in the Corporate Class Library,
and utilized to extend the PFC Ancestor Level. For example, corporate analysts may add
intermediate extension level(s) between the PFC Ancestor Level and the Extension Level, or
they can use the existing PFC Extension Level.

Depending on the business need and corporate complexity, sometimes the PFC Ancestor
Level is extended further into several layers containing corporate departmental standards and
business rules. These several layers are all included in the Corporate Class Library.

3.4.2.2 Defining migration objective progressively

If your PFC application's architecture has a large corporate layer, Appeon recommends
that you first aim to migrate a small application to the Web or portion of your existing PFC
application to get your framework working on the Web, then expand to deploy a larger
portion of your application or the entire application. This progressive approach prevents
you from being confronted by many problems at the same time; otherwise, you may be
overwhelmed with unsupported features that exist in both the application and the Corporate
Class Library.

Step 1: Deploy a small PFC application that consists of the following three parts:

• A small amount of application-specific logic separated from the Individual Application.

• Corporate Class Library

• PFC Ancestor Level

In this step, the application-specific logic should be kept small and simple so you can focus
on migrating the PFC Ancestor Level and the Corporate Class Library onto the Web. The
PFC Ancestor Level and Corporate Class Library are more important because they are the
base classes for all corporate applications.

Step 2: Gradually increase the size and complexity of Individual Applications, and change
your focus to fixing the Individual Applications for Web deployment.

3.5 Upgrading the original application

Appeon for PowerBuilder 2015 supports PowerBuilder 9, 10, 10.5, 11, 11.5, 12, 12.5, and
12.6. Any PowerBuilder source code that is intended for deployment to the Web MUST
first be upgraded to be 100% compatible with the required PowerBuilder version. If your
application is not upgraded, you will encounter runtime errors with the deployed Web
application.

3.5.1 Upgrading obsolete PBLs

When loading PBLs from a previous version (e.g. PowerBuilder 5) into a later version,
many error messages may appear in the PowerBuilder Output window. Since inheritance
propagates are an issue from the ancestor object to all its descendant objects, some of the
errors reported may actually come from a single source.

One common type of error found when upgrading PowerBuilder applications is string
corruption. To correct these errors, edit the source code (by selecting Edit Source from the
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context menu on the error item displayed in the Output window). Errors will disappear when
performing a Full Build to the application target.

3.5.2 Upgrading PFC applications

PFC applications intended for Appeon Web migration must be upgraded to be compliant
with PFC 9 or later. Some legacy PFC applications are based on the PFC 5.0 PBLs that have
been migrated to the newer version, and you should upgrade those applications to use the new
PFC 9 or later PBLs.

The PFC PFCOLD.PBL library contains obsolete objects that are not supported for Appeon
Web migration. If the original PowerBuilder application is a PFC application that uses
objects in the PFCOLD.PBL library, you should remove the objects when upgrading the
application to PFC 9 or later.

3.6 Preparing the target application

In this step, you need to process the original PowerBuilder application to create the target
application. This work focuses on transforming the original PowerBuilder application into
a target application that complies with Appeon architectural guidelines set in Supported PB
Features for Appeon Web (Web only).

3.6.1 Special processing required for PFC applications

Appeon supports most PFC features. As such, under most situations the existing PFC code
can also work under the Appeon environment without any modifications. However, there
are a few features that are not supported. For that handful of unsupported features, Appeon
would devise a workaround or alternate implementation of those features. Then, the PFC
framework would be enhanced with any auto-sensing feature that would detect whether
the PFC framework is being run as Client/Server or as Appeon Web. If Client/Server, then
for those features that Appeon does not support it will execute the original Client/Server
implementation. If Web, then only for those features that Appeon does not support it will
execute the modified implementation. Refer to Processing PFC Applications for detailed
instructions on how to modify the unsupported PFC features.

After modifying these unsupported features, you can deploy the PFC application just as how
you deploy a normal PowerBuilder application.

3.6.2 Processing application based on migration objectives

The following table shows what processing tasks you need to perform based on your
migration objective.

Table 3.2: Process application based on migration objectives

If you plan to migrate... Do the following...

Entire original application 1. Test the original PowerBuilder application and correct any
applications functionality or user interface problems.

Note: This step is for detecting and removing problems
that may have existed in legacy PowerBuilder applications
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If you plan to migrate... Do the following...
or problems caused by upgrading legacy PowerBuilder
applications.

2. Perform a full build and optimize the original PowerBuilder
application in PowerBuilder IDE.

A portion of the original
application

1. Extract the desired portion from the original PowerBuilder
application into a new PowerBuilder application target.

2. Test the application to ensure there are no bugs and that it
functions as expected.

3. Perform a full build and optimize this "extracted" portion of
your application in the PowerBuilder IDE.

Some DataWindows in the
original application

1. Create a new PowerBuilder application target in the same
workspace that holds the original PowerBuilder application.

2. Move the desired DataWindow objects from the original
PowerBuilder application to the new PowerBuilder
application target.

3. Add Windows, Menus, and a general UI for the application.
Code simple business logic to the new PowerBuilder
application in order to make it fully functional.

4. Test the new PowerBuilder application and correct any
problems with its functionality and user interface.

5. Perform a full build and optimize the new PowerBuilder
application in the PowerBuilder IDE.

3.7 Pre-configuring for the Web applications

3.7.1 Why is pre-configuration necessary

The following illustration of the Appeon migration solution helps explain why these pre-
configurations are necessary.

Figure 3.4: Before and after Appeon Web migration
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Before the Web migration, the heavy client of the target PowerBuilder application interacts
with the Database Server. If the application is distributed, the client also interacts with the
application server that hosts and executes important business logic for the target application.

After the Web migration, the Web application has an n-Tier Web architecture involving
Appeon Server as the middleware to hold business logic. This structure is called Browser
Server, because the Web application is accessed via Web browsers such as Internet Explorer.

Making the prospective Web application function in an n-Tier Web environment requires
more than just hosting the HTML user interface and the business logic on the servers.

3.7.2 Four pre-configuration tasks

As indicated by the numbers in Section 3.7.1, “Why is pre-configuration necessary”, four
pre-configuration steps are necessary:

Task #1: Manually set up the Web application database server (non-Appeon task). This task
is no different from setting up the PowerBuilder application database server.

Task #2: Manually set up communication between the back-end DB server and the
middleware Appeon Server. Specifically, set up JDBC data sources (non-Appeon task).

Refer to Chapter 4, Database Connection Setup in Appeon Server Configuration Guide
for .NET or in Appeon Server Configuration Guide for J2EE for instructions on this task.

Task #3: Set up communication between the Web application UI (hosted on the Web server)
and the Web application business logic (hosted on Appeon Server). This is done via the Web
server configuration for the application (Appeon task). This task is not required if Appeon
Server and Web server are set up on the same machine, because the communication will be
automatically set.

Refer to Web Server Configuration Guide for instructions on this task.

Task #4: Configure Appeon Developer so that it has sufficient information to automate the
task of converting and deploying the target PowerBuilder application (Appeon task).

Refer to Appeon Developer User Guide for instructions on this task.

3.8 Modifying unsupported features
Some PowerBuilder features cannot be supported because:

1. There are architectural differences between desktop applications and Web applications.
The functionality in a Web application is often limited with regards to desktop
applications.

2. The current version of Appeon for PowerBuilder does not support every PowerBuilder
programming feature.

Unsupported features, if not modified, will be commented out in the generated Web files.
The code that contains the unsupported features and other code that is dependent on those
unsupported features will stop working.

This step involves modifying the unsupported features that have some functional impact on
the running of the application. Some cosmetic features, such as "Border" property, can be
ignored during the modification process if they will not affect the application.
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3.8.1 How to identify unsupported features

Three primary sources of information can guide you in identifying Appeon-unsupported
features in the PowerBuilder applications:

• Unsupported Features Analysis (UFA) report - This tool is included in the Appeon
Developer toolbar. It scans the PowerBuilder application for its unsupported features and
assists you in making changes to unsupported features. For instructions on how to use the
UFA, refer to Chapter 5, Using UFA Tool in Appeon Developer User Guide.

• Code Insight - This tool is also included in the Appeon Developer toolbar. It helps you
directly identify unsupported code in the PowerBuilder painter. For instructions on how
to use the Code Insight, refer to Chapter 13, Developing with Code Insight in Appeon
Developer User Guide.

• Supported PB Features for Appeon Web (Web only) - This Help file is a searchable
HTML file that can be launched by clicking the Appeon Help button in the Appeon
Developer toolbar. It lists the supported and unsupported features in details and provides
recommendations for writing convertible PowerBuilder code following the Appeon coding
standards.

3.8.2 Feature modification methods

You can modify unsupported code by following the instructions in Chapter 4, Workarounds
for Unsupported Features in Workarounds & API Guide. The Guide provides examples of
some common unsupported features and ways to work around them.

The following two modification methods are included in Workarounds & API Guide, and
worth highlighted here because of their importance:

• (EAServer only) Encapsulating unsupported features into PowerBuilder non-visual user
objects (NVOs) and deploying the NVOs to Appeon Server.

This method can work around a vast number of unsupported features (both browser
limitations and Appeon limitations). Refer to Section 5.1, “Moving unsupported features to
Appeon Server as n-Tier NVOs” for instructions on this method.

• (Windows only) Using the Appeon workaround for distributed DataWindows.

Appeon Workaround PBL provides two objects appeondatawindow and appeondatastore,
and four functions GetFullState, SetFullState, GetChanges and SetChanges, for supporting
distributed DataWindows. Refer to Section 5.3, “Migrating distributed applications with
distributed DataWindows” for instructions on this method.

3.9 Enhancing the application with Web or Appeon features
This is an optional step. Some enhancement features can be automatically included in the
deployed application, but some features require you to make changes in the PowerBuilder
application first. The following lists the key enhancement features that you should add in the
PowerBuilder application to make them effective in the deployed application:

• Appeon Server open interfaces that can be called to manage all the applications run at
Appeon Server
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• Appeon client functions that can be called to get client information or enable Appeon
DataWindow menu

• Integration with other applications via CommandLine argument, or HyperLink controls

Chapter 6, Enhancing an application with Web or Appeon features provides you instructions
on how to implement a number of Web or Appeon features in the deployed application.

3.10 Trial deployments and debugging

Having completed the previous steps, the target PowerBuilder application is ready for the
first trial deployment.

Trial deployments are the intermediate deployments before the final go-live deployment. For
detailed instructions on deployment and running of Appeon Web applications, refer to the
Appeon Developer User Guide.

3.10.1 Special deployment steps for distributed applications

Special deployment steps are required for distributed applications with or without distributed
DataWindows. Refer to Chapter 5, Building and Migrating Distributed Applications
(EAServer Windows only) for instructions on deploying distributed applications.

3.10.2 Debugging deployed applications

There may be issues in the trial deployment. For example, a feature in the Web application
may work differently from the target PowerBuilder application or not work at all. These
issues are usually caused by unsupported features or known issues (documented in the
Appeon Release Bulletin). Since UFA cannot detect every single different feature between
Client/Server application and Browse/Server application, it is possible that your application
contains an unsupported feature.

It is essential to debug the Web application and find the cause of the problem. You can use
Appeon Debugger to debug an Appeon Web application. For detailed instructions, refer to
Chapter 7, Debugging Appeon Web Applications in Appeon Developer User Guide.

After modifying the target PowerBuilder application according to the debugging result,
perform another trial deployment to see if the Web errors still exist in the Web application.
The "Trial deployment -> Debug Web application" process may need to be repeated many
times before the Web application functions properly.

3.11 Fine-tuning the runtime performance

Given the architectural differences between Client/Server applications and Web applications,
each of these has advantages and disadvantages. Typically, Web applications offer better
server scalability, while Client/Server applications provide a superior user experience (i.e.
rich GUI) and better runtime performance.

Appeon Web applications offer the rich PowerBuilder GUI with the scalability of n-Tier
Web architecture. The rich PowerBuilder GUI ensures that the superior user experience
and high user productivity is preserved. The server scalability is comparable to J2EE
applications or .NET applications, if not better, since Appeon moves more processing
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from the server to the Client. The Appeon Performance Tuning Guide has laid out the
PowerBuilder programming features and coding styles that lead to poor Web performance,
and it provides suggestions/workarounds. Refer to the Appeon Performance Tuning Guide for
more information.

3.12 Go-live deployment
Go-live deployment deploys the target PowerBuilder application to your production servers.

Check the following settings in the Appeon Developer Application Profile before starting the
final deployment to your production servers:

• Set the Web file generation mode to Release - This encrypts the JavaScript code in the
Web application, thereby protecting your organizations business rules and intellectual
property.

• Turn off the "Performance Analyzer compliance" option - The data is not encrypted during
transmission at runtime, therefore, this option is recommended to use only at the test or
development stage.

• Turn off all Report options - This will reduce the size of Web files and boost the runtime
performance of the deployed Web application.

• Check that the required database types are properly configured and selected.

• Check that the required additional files (such as INI files, .NET/COM components, image
files, DLL/OCX files) are properly configured or selected.

Refer to the Appeon Developer User Guide for detailed instructions on how to perform
application deployment.

Check the following settings in Appeon Enterprise Manager after performing the final
deployment to your production servers:

• Configure and ensure that transaction objects and data sources in AEM can be successfully
connected.

• Check that Run Mode for the go-live application is set to Normal Mode.

• Check Configuration Summary for the go-live application to ensure they apply to the go-
live environment, such as DLL/OCX configurations, 32-bit/64-bit IE compatibility etc.

• Change the AEM default username and password as appropriate to ensure the security of
AEM

Refer to Appeon Server Configuration Guide for .NET or Appeon Server Configuration
Guide for J2EE for detailed instructions on how to configure AEM.

3.13 Go live
Go-live is the last step in the Web migration process for the application to go live
successfully without serious problems, Appeon strongly recommends you have done the
following tasks in all related areas to reduce the likelihood of go-live problems:
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Unsupported Features:

• Ensure there are no unsupported features in the application. At a minimum, the UFA report
should not list any unsupported features.

Performance fine-tune:

• Read and follow the best practices defined in the Appeon Performance Tuning Guide.

Functionality:

• Verify all application functionality is working properly. Functionality should be tested on
all the browser version(s) that will be supported. For example, IE 7 32-bit, IE 8 32-bit, IE
8 64-bit etc. Please note: if the application uses third-party DLLs/OCXs/OLEs then 64-bit
version of those files need to be packaged in order for the Web application to run correctly
on 64-bit browsers.

Hardware/Software configuration:

• Select appropriate hardware to install Appeon Server. Appeon can give some suggestions
based on the # of users, but in general use the most powerful server that customer has
budget for.

• Configure IIS settings properly. Appeon can give some suggestions based on the # of users
and type of hardware that will be used.

• Understand the Web browser and system configuration/settings requirements and ensure
that all users are aware of these requirements and that their browser settings are correct. If
third-party DLLs/OCXs/OLEs are used the Web browser and system settings will need to
be significantly changed, so if possible for ease of deployment and user satisfaction it is
most preferred to avoid any third-party DLLs/OCXs/OLEs.

Performance and scalability:

• Verify the application response time over "realistic" network connection. What we mean
by realistic is to use the same network connection (bandwidth and latency) that the average
user will use. Test all application functionality to ensure that the application performs well.

• Verify the application scalability. There are two ways to do this. One is to use a scalability
testing tool such as LoadRunner. The other option (and more preferred) would be to do
a partial beta test. Essentially, get a group of users together to simultaneously use the
system to see if any problems. The problems you are looking for is significant degradation
in performance when multiple users on the system and/or system instability (e.g. IIS or
database stops responding or crashes).

Beta test and controlled roll-out:

• Perform a beta test. Roll out the application to a smaller group of real users to see if
any major problems. Expectations should be set with the users that this is a "beta" not a
"live" situation. The users should be prepared that problems are likely to happen and they
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should be able to tolerate downtime of the system for several days or longer to correct any
problems that are found.

• Perform a controlled roll-out. After the beta test has run for sufficient time with no major
problems then increase the # of users.

Now go live! After the controlled-rollout has run for sufficient time with no major problems
then go live.
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4 Migration FAQ

4.1 How do I rapidly build a new Web application with Appeon for
PowerBuilder?

Step 1: Create a new application.

Quickly create a new PowerBuilder Client/Server application workspace in your
PowerBuilder IDE.

Step 2: Code for the application.

Enable the Appeon Code Insight tool that is included in Appeon Developer toolbar, and then
write code. With the Code Insight, you can get instant information on whether the new code
is supported by Appeon.

Step 3: Migrate the application automatically with Appeon Deployment Wizard.

After previous steps, your PowerBuilder application now contains features that are 100%
supported by Appeon. You do not need to modify any unsupported features. You can easily
migrate your Client/Server application to Browser/Server application with the deployment
wizard in Appeon Developer toolbar.

4.2 Does Appeon support every PowerBuilder feature?

The current version of Appeon does not support all PowerBuilder syntax. Unsupported
PowerBuilder syntax falls into two categories:

Category 1: PowerBuilder features that are Client/Server architecture specific, and cannot be
implemented in n-Tier Web applications.

Unsupported features in this category must be reworked for n-Tier architecture.

Category 2: PowerBuilder features that are currently unsupported by Appeon, but will
possibly be supported in the future.

Section 3.8, “Modifying unsupported features” gives you high-level instructions on how
to modify unsupported features. Chapter 4, Workarounds for Unsupported Features in
Workarounds & API Guide provides examples on some common unsupported features and
ways to work around them.

4.3 Do Appeon-deployed Web applications support external
resources?

Appeon supports using external resources in Web applications, such as INI and image files,
OCX and OLE controls, etc.

4.4 Why classify my application into types?

The PowerBuilder-to-Web process can be simple or complex depending on the type of
application being migrated. Appeon provides guidelines for different types of applications.
Once you have identified the type of application, follow the specific guidelines to get your
application on the Web even faster.
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4.5 What are the different application types?
PowerBuilder applications can be classified as one of three types.

Type 1 applications meet the following requirements and can be automatically deployed to
the Web:

• The application does not contain any functionality that cannot be implemented on the Web.

• The application does not contain any unsupported features.

• These types of applications tend to be below 50 MB (application PBLs including
Framework).

Type 2 applications contain some functionality that cannot be implemented on the Web,
and/or some unsupported features. The size of the application may be large, and/or the user
objects in the application may have complex interdependencies. Modify the objects or code
in the application and make it compliant with Supported PB Features for Appeon Web (Web
only).

Type 3 applications contain functions that cannot be implemented on the Web but are critical
to the functionality of the application and have very complex frameworks that do not align
well with Appeon supported features, such as PFC-based applications. Depending on the
business requirements and project scope, the developer can leverage the RAD capabilities
of PowerBuilder to get an application on the Web much faster than a typical J2EE or .NET
rewrite while preserving the rich PowerBuilder GUI.

4.6 What are the recommendations for converting the different
application types?
The following are recommendations for handling the different types of applications.

Type 1 applications: This type is ready to be migrated. There is no additional work to
do. Appeon reads the PowerBuilder PBLs and generates the n-Tier Web application. The
Web application will have DataWindows, business logic, and UIs identical to the original
PowerBuilder application.

Type 2 applications: The developer needs to remove the unsupported features and Client
Server specific functions from the application that cannot be implemented on the Web to
ensure that the Web deployed application functions in the same manner as the PowerBuilder
application. If the application is large and complex, Appeon suggests splitting it into smaller
applications to simplify the debugging of the application. Remove as many minor and
unnecessary features as possible. Simplify the code and object interdependencies to make the
application more straightforward. The DataWindows and a good portion of the PowerBuilder
source code can be utilized. The amount of PowerBuilder source code that can be reused
depends on the actual application's complexity and the user's requirements.

Type 3 applications: These generally cannot be migrated to the Web as-is, but the
DataWindows and other useful objects can be exported and used to rapidly build a more
straightforward PowerBuilder application using standard PowerBuilder programming.

The ultimate aim of the guidelines is to help you modify the PowerBuilder application and
make it well supported by Appeon. The existing DataWindows may be used. Depending on
the application type, modify a fraction, a part, or all of the PowerBuilder source code.
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4.7 What are the basic requirements for rewriting complex
applications?

The Supported PB Features for Appeon Web (Web only) outlines a set of requirements and
recommendations that should be followed. See Supported PB Features for Appeon Web
(Web only) for more information. Essentially, you must re-code portions of the application
to make the application more straightforward (by, for example, removing complex object
interdependencies and reducing the number of DataWindows and DataStores in a given
Window).

4.8 When would I need to modularize my application?

If the application is a Type 2 or Type 3 application, you may need to split the application
into smaller applications and deploy them separately depending on the actual migration
requirements.

4.9 What are the benefits of modularizing my application?

The following are advantages of splitting an application into smaller applications:

• Smaller applications have better performance when deployed to the Web.

• It is easier and more efficient to debug smaller applications and rework the unsupported
features.

• It allows several developers to work on one project simultaneously and improves developer
productivity because one or more developers can specialize on particular modules. The
modules can each be deployed to the Web and linked together through a unified HTML
interface.

4.10 What are the basic principles for modularizing an application?

The following are the basic principles for splitting an application into smaller applications
(modularizing):

The functionality of each small application should be independent from the others. Each
application to be deployed should be able to execute an independent and practical task.
Following this principle, it is better to integrate closely related functional points in a small
application and remove the loose object references. For example, to split a purchase order
application into smaller parts, the order management logic (module) can be placed in a
small application and the relevant supplier information management logic in another small
application.

On the basis of the first principle, try to balance the complex objects evenly across all the
small applications.

The applications should be as small as possible.

4.11 Can you give an example of the modularization process?

The following example highlights the process of modularization of an application:
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A purchase order application needs to be deployed to the Web. It is a large and complex
application that provides the following functionalities at a high-level:

• Order Input

• Order Management

• Supplier Management

• Resource Planning

• Reporting

According to business requirements, the most urgent application functions that must
be brought on to the Web as soon as possible are Order Input, Order Management, and
Reporting.

Based on the above business requirements, the first phase of the conversion process should
involve extracting the Order Input, Order Management and Report functionalities from the
original application and importing them back into PowerBuilder. This creates a new smaller
application.

Using Supported PB Features for Appeon Web (Web only) and Appeon Code Examples, you
can work around or modify the unsupported source code in the smaller application to bring it
into compliance and deploy it to the Web.
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5 Building and Migrating Distributed
Applications (EAServer Windows only)
Appeon Server for Windows EAServer edition supports migrating distributed applications
regardless of whether they contain server DataStores. If your non-distributed application
is large and contains complex logic or many unsupported features, consider building a
distributed application out of it by moving a portion of business logic to the server.

The migration process for distributed applications is essentially the same as outlined in
Chapter 3, Migration Process. However, you should carefully read the instructions in
this chapter, and perform special preparation or deployment process to ensure successful
migration. Refer to:

• Section 5.1, “Moving unsupported features to Appeon Server as n-Tier NVOs” for
details on the advantages, restrictions, and guidance of n-Tier NVO usage in distributed
applications.

• Section 5.2, “Migrating distributed applications without distributed DataWindows”
for special preparation tasks required for migration of distributed applications without
distributed DataWindows.

• Section 5.3, “Migrating distributed applications with distributed DataWindows” for special
workaround techniques for supporting the GetFullState, SetFullState, GetChanges and
SetChanges functions. Note that the workaround techniques only work with Appeon Server
for EAServer on Windows.

5.1 Moving unsupported features to Appeon Server as n-Tier NVOs

5.1.1 Strategy

When an application contains unsupported features, you can encapsulate some of them into
PowerBuilder non-visual user objects (NVOs) and deploy the NVOs to the EAServer hosting
Appeon Server. These NVOs can be called by Appeon Web applications as well as any other
Web application or PowerBuilder application.

This n-Tier NVO support allows the user to program powerful PowerBuilder features into the
application. If an existing PowerBuilder application is deployed to the Web, the n-Tier NVO
technique can work around a vast number of unsupported features (both browser limitations
and Appeon limitations).

5.1.2 Advantages of n-Tier NVO usage

With n-Tier NVOs, you can work around:

• A large amount of unsupported DataWindow (DW) syntax (functions, events, properties,
dot notation and expressions) in conjunction with the Appeon distributed DataWindow
technique (Windows only) (support of DW Get/SetFullState, Get/SetChanges)

• Some unsupported non-visual PowerBuilder system objects



Building and Migrating Distributed Applications
(EAServer Windows only)

Appeon® for PowerBuilder® 2015

Migration Guidelines for Appeon Web (Web only) Page 25

• Some unsupported system functions

N-Tier NVOs can also:

• Remove Web browser limitations by running PowerBuilder NVO code inside the
EAServer hosting Appeon Server

• Connect to DLLs

• Connect to other PowerBuilder NVOs & Java/EJBs in the EAServer hosting Appeon
Server.

• Connect to EJBs in Sybase EAServer, Oracle WebLogic, IBM WebSphere, TmaxSoft
JEUS, JBoss, and other J2EE-compliant application servers through PowerBuilder 9.0
PBNI/EJB support

• Connect to remote Web Services or .NET components

• Create and expose Web Services from PowerBuilder NVOs using the EAServer Web
Services Toolkit

• Connect to C++ Classes/DLLs through PBNI and vice-versa

• Connect to Messaging Systems through Message Queues (JMS, MQSeries, Tibco)

• Create XML result sets for sending to other companies/departments using PowerBuilder
9.0 XML DataWindow or PBDOM functionality

• Consume XML result sets from other companies/departments using PowerBuilder 9.0
XML DataWindow or PBDOM functionality

• Create PDF DataWindow files and/or manipulate text files using the PowerBuilder 9.0
DataWindow SaveAs (PDF) functionality

• Move logic and processing from the client to the server. The more you move to the server,
the faster the client will run and the lighter and less complex the Web files will be. For
example, there was an application from a large Japanese conglomerate that took more than
ten seconds to execute a DataWindow Update. The complex validation rules in the Update
were consolidated into n-Tier NVOs, and the DataWindow Update now only takes one
second.

5.1.3 Restrictions in n-Tier NVOs usage

Typically, what is encapsulated into n-Tier NVOs is the application business logic that is
not related to the visual aspects of the application. Not all of PowerBuilder's unsupported
features can be encapsulated into NVO components that run in Appeon Server working with
EAServer on Windows.

There are restrictions for n-Tier NVOs by EAServer and Appeon. For detailed information,
refer to Section 4.1.1, “N-Tier PowerBuilder NVOs (EAServer + Windows Only)” in
Supported PB Features for Appeon Web (Web only).
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5.1.4 Steps for moving unsupported features or business logic to Appeon
Server

Step 1: Create new PowerBuilder NVO objects; add user functions, events and/or properties
to them as necessary. Place unsupported code or business logic in these functions/events.

Step 2: Deploy the NVOs holding unsupported features to the EAServer hosting Appeon
Server that is used for Web deployment of the target PowerBuilder application. To deploy
an EAServer component from a PowerBuilder NVO, use the EAServer Component Project
wizard in PowerBuilder.

Step 3: Generate stubs and skeletons of the server NVO components that you have deployed
in the previous step.

Step 4: Make sure the Bind Thread property of each server component is enabled in the
Properties | Instances tab.

Step 5: Build the EAServer Proxy objects in the target application Client. The Proxy objects
act as agents for Server NVO Components. To define an EAServer Proxy object, use the
EAServer proxy object generator in the PowerBuilder Project painter.

Step 6: At the target application Client, modify the Connection object properties and connect
to the deployment Appeon Server.

Step 7: Instantiate the Server NVO Components and call their methods to replace the original
unsupported code in the target PowerBuilder application.

Step 8: Run and debug the target application in PowerBuilder to ensure the application client
works correctly with Server NVO Components, then perform a full build and optimize the
application target in the PowerBuilder IDE.

For more information on deploying and using EAServer components from PowerBuilder
NVOs, refer to PowerBuilder Help and Sybase EAServer documentation.

5.2 Migrating distributed applications without distributed
DataWindows

5.2.1 Generating Stub/Skeleton in EAServer

Stubs and skeleton files allow communication between a client and a component in
EAServer, regardless of the client and the server component types. For example, a Java or C+
+ client can be used to interact with a PowerBuilder NVO component in EAServer.

Stubs and skeletons for an Appeon Web application are the counterparts to EAServer Proxy
objects and EAServer Component objects in an n-Tier PowerBuilder application. Both the n-
Tier PowerBuilder application and the Appeon Web application call NVO components in an
EAServer. The Proxy object allows the PowerBuilder client to access the NVO components
on EAServer. Stubs allow the Appeon Web application to establish communication with the
EAServer and access its NVO components on Appeon Server.

For detailed instructions, refer to Section 5.8, “How to deploy NVO to EAServer 6.1” in
Workarounds & API Guide.
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5.2.2 Deploying the application

After the stubs and skeletons are generated as required for its n-Tier NVOs, the migration of
a distributed application that does not contain distributed DataWindows is similar to that of a
normal Client/Server application. You only need to create an application profile for the client
application of the distributed application, and deploy the application profile using the Appeon
Deployment Wizard.

5.3 Migrating distributed applications with distributed
DataWindows

5.3.1 Benefits in using distributed DataWindows

"Distributed DataWindows" refers to the use of DataWindow/DataStore objects in a
distributed environment. In a distributed PowerBuilder application, a DataWindow control
at the client can associate with a DataStore object in EAServer. The client DataWindow
control is responsible for the visual representation of data and deals with user operations,
while the DataStore object in EAServer is responsible for transactions. The state of the client
DataWindow control is synchronized with the state of the DataStore object in EAServer and
vice versa, using relevant DataWindow functions.

There are two benefits to using distributed DataWindow technology with Appeon:

• Provides more scalability by separating user interface and business logic.

• Works around Appeon unsupported DataWindow functions by moving the functions in
server DataStore objects.

5.3.2 Workaround required if you use distributed DataWindows

If you use distributed DataWindows in the application and plan to migrate the DataWindows
to the Web, you must use the workaround provided by Appeon for the distributed
DataWindows via:

1. Deriving distributed DataWindows and DataStore objects from appeondatawindow and
appeondatastore.

2. Deriving PowerBuilder GetFullState, SetFullState, GetChanges and SetChanges functions
from corresponding Appeon functions.

Because the workaround only works with Appeon Server installed to EAServer on Windows,
you should avoid using the distributed DataWindow technique if you plan to deploy the
application to an Appeon Server running on other application servers.

5.3.2.1 Why the workaround is required

PowerBuilder GetFullState, SetFullState, GetChanges and SetChanges functions use
BLOB (Binary Large Object) parameters for passing DataWindow or DataStore object
specifications. Appeon supports BLOB, but it cannot directly interpret the BLOB
DataWindow or DataStore object specifications. Appeon workarounds help to interpret the
BLOB DataWindow or DataStore object specifications.
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5.3.2.2 Main workaround steps

Step 1: Apply the workaround appeondatawindow objects and appeondatastore objects
provided by Appeon to your application.

For step-by-step instructions on how to apply them, refer to Section 4.6.1, “Appeon
GetFullState/SetFullState/GetChanges/SetChanges (Windows only)” in Workarounds & API
Guide.

Step 2: In PowerBuilder, deploy the server DataStores that are inherited from
appeondatastore to Appeon Server.

You also need to deploy the appeondatawindow and appeondatastore objects to the Appeon
Server.

Step 3: Generate stubs and skeletons for the server DataStores in the application by following
the instructions in Section 5.8, “How to deploy NVO to EAServer 6.1” in Workarounds &
API Guide.

5.3.2.3 Workaround limitations

When using the appeondatawindow and appeondatastore objects to work around the
distributed DataWindow technique, there are some limitations regarding the use of Appeon
GetFullState, SetFullState, GetChanges, and SetChanges functions.

Table 5.1: Limitations of Appeon workaround

Limitation/Difference in Limitation/Difference Description

DataWindow styles The workaround works with DataWindows or DataStores of all
styles, except for OLE and Treeview.

The return value of Appeon SetFullState may have different
meaning from that of PowerBuilder system SetFullState
function.

The Appeon GetChanges function always returns -1 if it fails. In
PowerBuilder, the function can return more error numbers (-1,
-2 and -3).

Return value of the
functions

The Appeon SetChanges function can return -1 and -3, but
cannot return 2 and -2.

DataWindow ImportString
function

If using the DataWindow ImportString function in a distributed
DataWindow environment, keep the date display format the
same at the client and Appeon Server machines. In addition, the
date/time format configuration in AEM should be kept the same
as the system date/time configuration on Appeon Server.

State information
initialization of a
DataWindow/DataStore

In PowerBuilder, the state information of a DataWindow/
DataStore is initialized whenever you set its DataObject
property. However, if using appeondatawindow and
appeondatastore, the state information is initialized only when
you change the DataObject property to a different DataWindow
object.

Truncation of characters in
certain cases

When applying Appeon SetChanges to a target DataWindow/
DataStore, if a column of Char type in the source DataWindow/
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Limitation/Difference in Limitation/Difference Description
DataStore has defined more characters than its corresponding
column in the target DataWindow/DataStore, characters from
the source column that exceed the length limit of the target
column are truncated, but in PowerBuilder the extra characters
are preserved.

Un-modified or modified
data

When calling PowerBuilder GetFullState and GetChanges,
changed (but not accepted) data in a DataWindow control
is treated as un-modified data, but if using the Appeon
appeondatawindow and appeondatastore, changed (but not
accepted) data is treated as modified data.
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6 Enhancing an application with Web or
Appeon features
The following table gives you a general idea on how to enhance applications with Web or
Appeon features.

Table 6.1: Enhance a deployed application with Web/Appeon features

Type of the
Feature

Description of the Feature How to add it in the deployed
application

Typical Web
features

• Accessibility of the application via URLs
or Sybase Enterprise Portal

• Firewall compatibility. The Web file
transfer is HTTP over port 80.

• SSL and digital certificate security

• Superior scalability. Typical applications
support 60-80 concurrent users per server
CPU that maps to 300-500 named/end
users per server CPU.

• More...

Such features are automatically
added in the deployment
application, with no need for
any special coding.

Refer to Section 6.3, “Loading
an application in Sybase
Enterprise Portal” for details
on how to load the application
in Enterprise Portal.

Appeon
Server open
interfaces

Use Appeon Server open interfaces to
manage Appeon-deployed Web applications
using PowerBuilder code.

The interface(s) should be
called in the PowerBuilder
application to take effect in the
deployed application.

Refer to Section 6.1, “Appeon
Server open interfaces” for
details.

Appeon client
functions

Use Appeon client functions to get client
information or server information, or
use Appeon enhanced features in the
applications.

The client function(s) should
be called in the PowerBuilder
application to take effect in the
deployed application.

Refer to Section 6.2, “Appeon
client functions” for details.

Web
integration

• Provides flexible & open Java, .NET, &
Web Services integration

• Connectivity to Java/EJB, PB NVO, C/C
++ DLL, COM/ActiveX Components on
Application Servers

• Connectivity to Web Services, J2EE,
and .NET

There are different ways for
implementing the integration
of an Appeon Web application
with other applications.

Refer to Section 6.4, “Single
sign-on” and Section 6.5,
“Integrating Appeon Web
applications with JSP/ASP” for
details.
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Type of the
Feature

Description of the Feature How to add it in the deployed
application

• Connectivity to Messaging Queues
(MQSeries, JMS, etc.)

6.1 Appeon Server open interfaces
Appeon Server open interfaces give you the opportunity to manage services provided by
Appeon Server through PowerBuilder code. You can easily manage Appeon-deployed Web
applications with the open interfaces below:

• getSessionCount

• killAllSessions

• killSessions

• rollbackAllTransactions

• getAllClients

• getAllSessions

6.1.1 Description of the open interfaces

Refer to Section 5.1, “Appeon enhancements and differences” in Supported PB Features
for Appeon Web (Web only) for the syntax of Appeon Server open interfaces. Note that you
can write code for calling the interface in the PowerBuilder application, but the code does
not take effect in the PowerBuilder application; it only takes effect in the Appeon-deployed
application.

6.1.1.1 getSessionCount

With getSessionCount method, you can get the following three types of information.

• The total number of active sessions opened for the specified application in the specified
Appeon Server.

• The total number of active sessions in a specified Appeon Server.

• The total number of sessions opened for the specified application in an Appeon Server
cluster.

To get the number of sessions in an Appeon Server cluster, you need to first configure the
cluster in AEM.

By using the AppeonGetSessionCount method, you can easily get the total number of active
sessions in a specified Appeon Server using PowerBuilder code and apply the information in
other open interfaces such as KillSession to manage the sessions. For example, you can first
call AppeonGetSessionCount and then call KillSession in the PowerBuilder application to
make the deployed application kill all sessions in Appeon Server when there are up to 100
active sessions in the server.
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6.1.1.2 killAllSessions

killAllSessions kills all active sessions in an Appeon Server or an Appeon Server cluster and
rolls back all associated transactions. To kill all sessions in an Appeon Server cluster, you
need to first configure the cluster in AEM.

6.1.1.3 killSessions

killSessions kills the specified session(s) in an Appeon Server or an Appeon Server cluster
and rolls back the associated transactions. To kill sessions in an Appeon Server cluster, you
need to first configure the cluster in AEM.

6.1.1.4 rollbackAllTransactions

rollbackAllTransactions rolls back all transactions in an Appeon Server or an Appeon Server
cluster. To roll back all transactions in an Appeon Server cluster, you need to first configure
the cluster in AEM.

6.1.1.5 getAllClients

getAllClients gets the IP addresses of all client machines which corresponds to the active
sessions that are opened for the specified application in the specified Appeon Server.

6.1.1.6 getAllSessions

getAllSessions returns the detail information of active sessions with XML format, which are
opened for the specific application in the specific Appeon Server.

6.1.2 Applying Appeon Server open interfaces in Appeon-deployed
applications

To apply an Appeon Server open interface in an Appeon-deployed Web application, you only
need to perform the following two steps.

1. Call the Appeon Server open interface in the PowerBuilder application. For how to call
Appeon Server open interfaces in a PowerBuilder application, refer to Section 5.1.3.1,
“Calling Appeon Server open interfaces for J2EE application servers” in Supported PB
Features for Appeon Web (Web only) or Section 5.1.3.2, “Calling Appeon Server open
interfaces for IIS Server” in Supported PB Features for Appeon Web (Web only).

2. Deploy the PowerBuilder application to Appeon Server the same way you would deploy a
normal PowerBuilder application.

6.2 Appeon client functions
Appeon client functions are a set of PowerBuilder functions encapsulated in Appeon
workaround PBLs. You can add Appeon client functions in your PowerBuilder applications
to achieve the following in Appeon-deployed applications:

• Get client information, such as the IP address, or the browser type of the client

• Get server information, such as total numbers of the active session on a cluster or a single
Appeon server.
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• Use Appeon Web enhanced features, such as Appeon DataWindow menu, PDF print, and
LDAP Logon.

6.2.1 Description of Appeon client functions

The following table provides the client functions and their return values. Note that some
Appeon client functions are just interfaces provided by the Appeon system; they have empty
function bodies and empty return values for the PowerBuilder applications.

Table 6.2: Client functions with their return values

Functions Return value when
executed in PowerBuilder

Return value when
executed in Appeon
application

AppeonGetAppeonUserName() None.

This function has no effect
in PowerBuilder.

The user name typed into
the Appeon Login dialog.

AppeonGetBrowserVersion() None.

This function has no effect
in PowerBuilder.

The version of the Internet
Explorer browser that
runs the current Web
application.

AppeonGetClientID() The unique session
identifier for PowerBuilder
client.

The unique session
identifier for the Web
client.

AppeonGetCacheDir() None.

This function has no effect
in PowerBuilder.

The cache directory that is
used by the current Web
application.

AppeonGetClientIP() The IP address of
PowerBuilder client
machine.

The IP address of the Web
client.

AppeonGetClientType() "PB" "WEB" if the application
runs on a Web browser,
or "MOBILE" if the
application runs on a
mobile device.

AppeonGetHttpInfo (string
attribute)

None.

This function has no effect
in PowerBuilder.

The HTTP header
information from a
particular request.

AppeonGetIEHandle() None.

This function has no effect
in PowerBuilder.

The Internet Explorer
handle for the current Web
application.

AppeonGetIEURL() None.

This function has no effect
in PowerBuilder.

The URL of the current
Appeon application.
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Functions Return value when
executed in PowerBuilder

Return value when
executed in Appeon
application

AppeonGetOSType() The type of the OS that
runs the PowerBuilder
client application.

The type of the OS that
runs the current Web
application.

AppeonGetRemainingdays
(String as_type, ref string
as_error)

None.

This function has no effect
in PowerBuilder.

The remaining day(s) of
license or technical support.

AppeonGetSessionCount None.

This function has no effect
in PowerBuilder.

The total number of active
sessions opened for the
specified application in the
specified Appeon Server.

AppeonGetServerType() None.

This function has no effect
in PowerBuilder.

Returns 1 if the application
runs on an Appeon Server
that is installed to a J2EE
Server (such as WebLogic).

Returns 2 if the application
runs on an Appeon Server
that is installed to a
Microsoft .NET Framework
\IIS.

AppeonIsIn64Browser None. This function has no
effect in PowerBuilder.

Returns "true" if the
application runs on a 64-bit
IE browser. Returns "false"
if the application runs on a
32-bit IE browser.

AppeonLDAPLogon (string
as_username, string as_password)

None.

This function has no effect
in PowerBuilder.

Login username and
password for the LDAP
server.

AppeonPopMenu (Datawindow
adw_dw, Integer nx, Integer ny)

None.

This function has no effect
in PowerBuilder.

None.

At the execution
of the function,
AppeonDataWindow menu
is displayed at the specified
position on the specified
DataWindow control.

AppeonPopMenu has
higher priority than
AppeonPopMenuOn.

AppeonPopMenuOn
(Datawindow adw_dw, Boolean
ab_show)

None.

This function has no effect
in PowerBuilder.

None.

At the execution
of the function,
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Functions Return value when
executed in PowerBuilder

Return value when
executed in Appeon
application
AppeonDataWindow menu
pops up when you right
click on the specified
DataWindow.

AppeonPrint2File (datawindow
adw, string asoutpath, string
asoutname, long alouttype)

None.

This function has no effect
in PowerBuilder.

Integer.

Returns 1 if it succeeds
in printing the specified
DataWindow/DataStore as
a PDF or an image file of
BMP, JPG or GIF format,
otherwise, returns -1.

AppeonSwitchRealTimeCalc None. This function has no
effect in PowerBuilder.

Returns 0 (default value) if
need to perform real-time
calculation. Returns 1 if no
need to perform real-time
calculation.

6.2.2 Using Appeon Client functions

Although the main purpose of Appeon Client functions is to implement certain functionalities
in Appeon-deployed applications, you must call the functions in your PowerBuilder
application to make the functions effective.

To use Appeon Client functions in Appeon-deployed applications, refer to Section 2.3.2,
“Appeon Client Functions” in Workarounds & API Guide for more detail.

6.3 Loading an application in Sybase Enterprise Portal
Sybase Enterprise Portal (EP) is an open and scalable portal framework that provides
an intuitive, secure and customized environment for end-users; rapid development and
deployment tools for developers; and an easy-to-use console for administrators. Appeon-
deployed applications can run in Sybase Enterprise Portal or Unwired Accelerator.

6.3.1 Restrictions on supporting Enterprise Portal

Appeon supports Enterprise Portal 6.1 Info Edition and Enterprise Edition. Be aware of the
following restrictions when you load Appeon Web applications in Enterprise Portal:

• Only ONE Appeon Web application can be viewed inside one EP Page. Multiple Appeon
Web applications can be viewed within multiple pages. For example, you can have Sales
App Demo on one EP Page and Appeon Code Examples on another EP Page and both
function correctly.

• Exiting from Appeon Web applications do not close Internet Explorer.

• Only one response window is allowed for an Internet Explorer browser at a given time.
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6.3.2 Tasks required to load the application in Enterprise Portal

You need to perform the following four tasks to get a deployed application loaded in the
portal after the application migration:

Task #1: Add the application into a portlet. Create an HTML element in the portlet and assign
the URL of the Appeon-deployed application to the HTML element.

Task #2: Add the application into a page. Create a new page, add the application into it, and
approve the application.

Task #3: Add the page into a page group. Create a new page group and add the page created
in task #2 into the page group.

Task #4: Create accounts for viewing the application. Create accounts and assign rights to the
accounts for running the application.

For step-by-step instructions on conducting each of the preceding tasks, refer to the relevant
documentation provided by Sybase Enterprise Portal (available at http://www.sybase.com/
products/archivedproducts/enterpriseportal/technicalsupport).

6.4 Single sign-on
Single sign-on can be implemented in the Appeon deployed Web applications using the
following two methods:

• Using a server component to manage user information

• Applying command line argument

For detailed steps of using the above methods, refer to Section 5.12, “How to log in the Web
application with single sign-on” in Workarounds & API Guide.

6.5 Integrating Appeon Web applications with JSP/ASP
You can integrate Appeon Web applications with JSP/ASP applications using the following
three methods:

• Applying Appeon CommandParm and Hyperlink features

• Using Internet Explorer frame

• Integration through intermediate n-Tier server

For detailed steps of using the above methods, refer to Section 5.16, “How to integrate
Appeon Web applications with JSP/ASP” in Workarounds & API Guide.

http://www.sybase.com/products/archivedproducts/enterpriseportal/technicalsupport
http://www.sybase.com/products/archivedproducts/enterpriseportal/technicalsupport
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7 Processing PFC Applications
Appeon supports most PFC features. As such, under most situations the existing PFC code
can also work under the Appeon environment without any modifications. However, there
are a few features that are not supported. For that handful of unsupported features, Appeon
would devise a workaround or alternate implementation of those features. Then, the PFC
framework would be enhanced with any auto-sensing feature that would detect whether
the PFC framework is being run as Client/Server or as Appeon Web. If Client/Server, then
for those features that Appeon does not support it will execute the original Client/Server
implementation. If Web, then only for those features that Appeon does not support it will
execute the modified implementation.

After modifying these unsupported features, you can deploy the PFC application just as how
you deploy a normal PowerBuilder application.

7.1 Auto-Sensing Environment

The general idea of making PFC work for both PowerBuilder and Appeon is calling a global
function to judge the application's running environment. This global function will help to
judge whether to run the original PFC code or Appeon compliant code.

The global function "appeongetclienttype" is included in the Appeon Workarounds PBL. You
will need to first add the appeon_workarounds.pbl library to your application and then call
the appeongetclienttype global function. For detailed instructions, refer to Chapter 2, Appeon
Workarounds PBL Reference in Workarounds & API Guide.

7.2 Suggested Modifications to PFC

The following sections give detailed suggestions for how to modify current PFC codes so
that those Appeon unsupported or modified PFC features work in both PowerBuilder and
in Appeon. Code modifications are only made where absolutely necessary and the "Auto-
Sensing Environment" feature will be used to ensure under no circumstance are existing
Client/Server users affected by any Appeon modifications. Appeon suggested modification
will follow the following format:

IF appeongetclienttype() = "PB" then
 Original code in PFC
else
 Appeon compliant code in PFC
End if

7.3 Unsupported user objects

PFC framework contains the following user objects as unsupported (in the last two lines):
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Figure 7.1: Unsupported User objects in PFC

Recommendation: Although these user objects are defined, they are not referred to in PFC
framework, therefore you do not need to modify them and you should avoid referring to these
objects in your application.

7.4 Unsupported standard class objects
These four standard class objects are unsupported:

• Contextinformation

• Classdefinition

• Scriptdefinition

• Variabledefinition

Recommendation: Avoid referring to the following object functions, this can reduce the
impact on the functionality:

• pfcmain.pbl\pfc_w_master\of_setresize

• pfcapsrv.pbl\pfc_n_cst_security\of_setsecurity

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_findmatchingevent

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_findmatchingvariable

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_getancestorclasses

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_isfunctiondefined

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_iseventimplemented

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_iseventdefined

• pfcapsrv.pbl\pfc_n_cst_metaclass\of_isancestorclass

If you really need to use Classdefinition, try to use the following workaround:

Original script:

lb_defined = inv_metaclass.of_isFunctionDefined &
(lpo_tocheck.ClassDefinition, "of_PostUpdate", ls_args)
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Modified script:

If lpo_tocheck.TriggerEvent("pfc_descendant") = 1 Then
 lb_defined = True
Else
 lb_defined = False
End if

7.5 Unsupported object properties

Table 7.1: Unsupported object properties that need no modification

Object Properties Calls Suggestion

ToolbarUserControl 4

ToolbarText 5

ToolbarPopMenuText 3

DwMessageTitle 4

Application

DdeTimeOut 3

Need no modification.

ClassShortName 1OLEControl

ClassLongName 1

Need no modification.

Lock 3Transaction

Sqlreturndata 1

Need no modification.

Returnvalue 1

Number 1

Message

Handle 1

Need no modification.

Trace 2

Options 2

Connection

Connectstring 2

Need no modification.

GraphicObject Classdefinition 1 Need no modification.

Table 7.2: Unsupported object properties that need modification

Object Properties Calls Suggestion

Window Classdefinition 1 Need modification.

Calling this property has no impact on the
functionality. However, it has impact on the position
and size of the control in a DataWindow when the
DataWindow is zoomed in or zoomed out. Refer to the
detailed information below.

DETAILED INFORMATION

Location: Of_setresize(boolean) function of
pfc_w_master in pfcmain.pbl

Appeon Unsupported Code: Lcd_class =
this.ClassDefinition

Line Number: 45
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Object Properties Calls Suggestion
Change the code to:

if AppeonGetClientType( ) = 'PB' then
 classdefinition lcd_class
 lcd_class = this.ClassDefinition   
 li_vars = UpperBound ( lcd_class.VariableList )
 For li_v = 1 to li_vars
  If lcd_class.VariableList[li_v].Name = "width"
 then &
   li_origwidth = Integer
 ( lcd_class.VariableList[li_v].InitialValue ) 
  If lcd_class.VariableList[li_v].Name = "height"
 then &
   li_origheight = Integer
 ( lcd_class.VariableList[li_v].InitialValue ) 
  If li_origwidth > 0 And li_origheight > 0 then
 &
  Exit
Next
 inv_resize.of_SetOrigSize ( li_origwidth,
 li_origheight )
else
 inv_resize.of_SetOrigSize ( this.width,
 this.height )
end if

PowerObject Classdefinition 7 Need modification

This property is often used for detecting a function of
a object.

It is suggested to modify the whole code segment,
calling a function no matter whether it exists or not.
Refer to the detailed information below.

DETAILED INFORMATION

Location 1: Of_validation(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lcd_class =
this.ClassDefinition

Line Number: 123

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =
 inv_metaclass.of_isFunctionDefined 
  & (lpo_tocheck.ClassDefinition,
 "of_Validation", ls_args)
else
  lb_defined = True
End if

Location 2: Of_updatespending(powerobject) function
of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of_isFunctionDefined
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Object Properties Calls Suggestion
(lpo_tocheck.ClassDefinition, "of_UpdatesPending",
ls_args)

Line Number: 130

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =
 inv_metaclass.of_isFunctionDefined 
  & (lpo_tocheck.ClassDefinition,
 "of_UpdatesPending", ls_args)
Else
 lb_defined = True
End if

Location 3: Of_updateprep(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of_isFunctionDefined
(lpo_tocheck.ClassDefinition, "of_UpdatePrep",
ls_args)

Line Number: 122

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =
 inv_metaclass.of_isFunctionDefined 
  & (lpo_tocheck.ClassDefinition,
 "of_UpdatePrep", ls_args)
else
  lb_defined = True
End if

Location 4: Of_update(powerobject,boolean,boolean)
function of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of_isFunctionDefined
(lpo_tocheck.ClassDefinition, "of_Update", ls_args)

Line Number: 145

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =
 inv_metaclass.of_isFunctionDefined 
  & (lpo_tocheck.ClassDefinition, "of_Update",
 ls_args)
Else
  lb_defined = True
End if

However, with the suggested changes made, only
DataWindows placed directly on windows would
update. For DataWindows placed on tab pages to
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Object Properties Calls Suggestion
update correctly, add the code to the Case statement in
the function to call of_update() on UserObject and Tab
controls to make updates on tab pages work correctly.

Location 5: Of_postupdate(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of_isFunctionDefined
(lpo_tocheck.ClassDefinition, " of_PostUpdate ",
ls_args)

Line Number: 123

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =inv_metaclass.of_isFunctionDefined 
  & (lpo_tocheck.ClassDefinition,
 "of_PostUpdate", ls_args)
else
  lb_defined = True
End if

Location 6: Of_isselfupdatingobject(powerobject)
function of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of_isFunctionDefined
(apo_control.ClassDefinition, "of_Update", ls_args)

Line Number: 60

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =inv_metaclass.of_isFunctionDefined 
  & (apo_control.ClassDefinition, "of_Update",
 ls_args)
else
  lb_defined =True
End if

Location 7: Of_accepttext(powerobject,boolean)
function of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of_isFunctionDefined
(lpo_tocheck.ClassDefinition, "of_AcceptText",
ls_args)

Line Number: 128

Change the code to:

if AppeonGetClientType( ) = 'PB' then
  lb_defined =
 inv_metaclass.of_isFunctionDefined 
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Object Properties Calls Suggestion
  & (lpo_tocheck.ClassDefinition,
 "of_AcceptText", ls_args)
else
  lb_defined = True
End if

DataWindow
control

Hsplitscroll 1 Need modification.

Refer to the detailed information below.

Location: Of_position(dragobject,boolean) function of
pfc_n_cst_dropdown in pfcapsrv.pbl

Appeon Unsupported Code: If ldw_object.hsplitscroll

Line Number: 237

Change the code to:

if AppeonGetClientType( ) = 'PB' then
 li_hsplit = Integer (ldw_object.Describe
 ("DataWindow.HorizontalScrollSplit"))
 li_hpos1 = Integer (ldw_object.Describe
 ("DataWindow.HorizontalScrollPosition"))
 li_hpos2 = Integer (ldw_object.Describe
 ("DataWindow.HorizontalScrollPosition2"))
  if ldw_object.hsplitscroll then
   if li_hsplit > 4 and li_pointerx > li_hsplit
 then
    li_hpos = li_hpos2 - li_hsplit -
 of_GetSystemSetting (DW_HSPLITBAR_WIDTH)
   else
    li_hpos = li_hpos1
   End if
  else
   li_hpos = li_hpos1
  End if
else
 li_hpos = 0
End if

7.6 Unsupported object functions

Table 7.3: Unsupported object functions that need no modification

Object Functions Calls Suggestion

NonVisualObject GetContextService 1 Need no modification.

Settoolbar 5

Gettoolbar 3

Gettoolbarpos 2

Window

Settoolbarpos 2

Need no modification.

SingleLineEdit Canundo 1 Need no modification.

RichTextEdit Canundo 1 Need no modification.

UpdateLinksDialog 1OLEControl

PasteSpecial 1

Need no modification.
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Object Functions Calls Suggestion

Paste 1

Cut 1

Copy 1

EditMask Canundo 1 Need no modification.

DataStore ReselectRow 1 Need no modification.

7.7 Unsupported object events

Table 7.4: Unsupported object events that need no modification

Object Events Suggestion

PrintHeaderRichTextEdit

FileExists

Need no modification.

ListView Sort Need no modification.

Application SystemError Need no modification.

7.8 Unsupported system functions

Table 7.5: Unsupported system functions that need no modification

System functions Calls Suggestion

ShowHelp 18 Need no modification.

FindClassDefinition 6 Need no modification.

7.9 Unsupported Shared variables

Table 7.6: Unsupported shared variables that need no modification

Shared variables Calls Suggestion

snv_property 5 Need no modification.

7.10 Unsupported Function not found

Table 7.7: Unsupported functions that need no modification

Functions Calls Suggestion

dwObject.GetChild 1 Need no modification.

Table 7.8: Unsupported functions that need no modification

Functions Calls Suggestion

dwObject.Print 3 Need modification. Refer to the detailed information below.

DETAILED INFORMATION

Location 1: Pfc_print() event of pfc_u_dw in pfcmain.pbl

Appeon Unsupported Code: Li_rc = lds_selection.Print(true, true)

Line Number: 75
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Functions Calls Suggestion
Change the code to:

if IsValid (lds_selection) then
 If AppeonGetClientType( ) = 'PB' then
  li_rc = lds_selection.Print (true, true)
 else
  li_rc = lds_selection.Print (true)
 end if
  destroy lds_selection
else
 If AppeonGetClientType() = 'PB' then
  li_rc = this.Print (true, true)
 else
  li_rc = this.Print (true)
 end if
end if

Location 2: Pfc_print() event of pfc_n_ds in pfcmain.pbl

Appeon Unsupported Code: Li_rc = lds_selection.Print(true, true)

Line Number: 87

Change the code to:

if IsValid (lds_selection) then
 if AppeonGetClientType( ) = 'PB' then
  i_rc =lds_selection.Print (true, true)
 else 
  li_rc = lds_selection.Print (true)
 end if
  destroy lds_selection
else
 If AppeonGetClientType() = 'PB' then
  li_rc = this.Print (true, true)
 else
  li_rc = this.Print (true)
 end if
end if

7.11 Unsupported calls

Table 7.9: Unsupported calls

Unsupported calls Suggestion

Calling the
SQLPreview
event by Update
or ReselectRow
functions is
unsupported.

Need modification. Refer to the detailed information below.

DETAILED INFORMATION

Location: Of_setupdatestyle function of the
Pfc_n_cst_dwsrv_linkage object in pfcdwsrv.pbl

Add the following code:

if ai_style = TOPDOWN_BOTTOMUP then
  ai_style = BOTTOMUP
end if
if ai_style = BOTTOMUP_TOPDOWN then 
  ai_style = BOTTOMUP
end if
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Unsupported calls Suggestion

Dynamically calling
overloaded function
of an uncertain object
is unsupported.

Need modification. Refer to the detailed information below.

DETAILED INFORMATION

Location: Of_update(powerobject,boolean,boolean) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: li_rc = lpo_tocheck.Function Dynamic
of_Update (ab_accepttext, ab_resetflag, lpo_updaterequestor)

Line Number: 147

Change the code to:

u_dw   ldw_update
n_ds   lds_update
u_lvs   llvs_update
u_tvs   ltvs_update
if AppeonGetClientType( ) = 'PB' then 
 If lb_defined then 
  li_rc = lpo_tocheck.Dynamic of_Update (ab_accepttext,
 ab_resetflag, lpo_updaterequestor)
   if li_rc < 0 Then
    Return -1
    Continue
   End if
 else
  if lb_defined then 
   Choose Case Typeof ( lpo_tocheck)
   Case DataWindow!
    ldw_update = lpo_tocheck
    li_rc = ldw_update.of_Update (ab_accepttext,
 ab_resetflag, lpo_updaterequestor)
     if li_rc < 0 then Return -1
   Continue
   Case ListView!
    llvs_update = lpo_tocheck
    li_rc = llvs_update.of_Update (ab_accepttext,
 ab_resetflag, lpo_updaterequestor)
     If li_rc < 0 Then return -1
   Continue
   Case TreeView!
    ltvs_update = lpo_tocheck
    li_rc= ltvs_update.of_Update (ab_accepttext,
 ab_resetflag, lpo_updaterequestor)
     if li_rc < 0 Then return -1
   Continue
   Case DataStore!
    lds_update = lpo_tocheck
    li_rc= lds_update.of_Update (ab_accepttext, ab_resetflag,
 lpo_updaterequestor)
     if li_rc < 0 Then return -1
   Continue
  End choose
 End if
end if
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7.12 Differently behaved features

Table 7.10: Differently behaved features

Object Suggestion

WorkSpaceXMDI frames

WorkSpaceY

Need modification. Refer to the detailed information below.

Location: Of_setposition () function of pfc_w_statusbar in
pfcwnsrv.pbl

Line Number: 72

Suggested Modifications:

Step 1: Add the rect structure variable to the pfcwnsrv.pbl
with the following format.

global type rect from structure

long left

long top

long right

long bottom

end type

Step 2: Declare a local external function in the
pfc_w_statusbar.

Function long GetWindowRect (long hwnd , ref rect lpRect)
Library "user32"

Step 3: Rewrite the scripts in the Current PFC into the
following:

long ll_bottompos, ll_rtn, ll_TopPos, ll_LeftPos
rect lr_WinRect
ll_rtn = getwindowrect (handle (iw_parentwindow),
 lr_WinRect)
ll_LeftPos = PixelsToUnits (lr_WinRect.Left,
 XPixelsToUnits!)
ll_TopPos = PixelsToUnits (lr_WinRect.Top,
 YPixelsToUnits!)
ll_bottompos = PixelsToUnits (lr_WinRect.bottom,
 YPixelsToUnits!)
If AppeonGetClientType( ) = 'PB' then
 // The Y Position of the Status Bar is the Bottom of 
 // the Frame Window minus the MicroHelpHeight minus 
 // the MicroHelpBorderHeight.
 ll_microhelp_ypos = & 
 (iw_parentwindow.y + iw_parentwindow.height +
 li_ypos_extra) - & 
 (iw_parentwindow.mdi_1.microhelpheight +
 ii_borderheight)
 
 // The desired X Position of the Status Bar is the 
 // Frame Right End minus the StatusBar window.  Also
 // subtract the extra spacing on win95.
 ll_desiredstatubar_xpos = & 



Processing PFC Applications Appeon® for PowerBuilder® 2015

Migration Guidelines for Appeon Web (Web only) Page 48

Object Suggestion
 iw_parentwindow.x + iw_parentwindow.workspacewidth()
 + 
 & ii_borderwidth - (ii_winmaxwidth + 12 +
 li_xpos_extra)
 
 // The Frame X Position.
 ll_frame_xpos = iw_parentwindow.x  +
 (2*ii_borderwidth) + 16
 if ll_desiredstatubar_xpos < ll_frame_xpos then
 // Status Bar would extend to the left of the frame.
  this.move(ll_frame_xpos , ll_microhelp_ypos)
  // Make the StatuBar the width of the frame.
  this.width = workspacewidth(iw_parentwindow) - (20 +
 li_xpos_extra)
 else 
  // Normal as large as defined Status Bar window.
  this.move(ll_desiredstatubar_xpos ,
 ll_microhelp_ypos)
  this.width = ii_winmaxwidth
 end if
 else
 // The Y Position of the Status Bar is the Bottom of 
 // the Frame Window minus the MicroHelpHeight minus 
 // the MicroHelpBorderHeight.
 ll_microhelp_ypos = & 
 (ll_TopPos + iw_parentwindow.height + li_ypos_extra)
 - 
 & (iw_parentwindow.mdi_1.microhelpheight +
 ii_borderheight)
 // The desired X Position of the Status Bar is the 
 // Frame Right End minus the StatusBar window.  
 // Also subtract the extra spacing on win95.
 ll_desiredstatubar_xpos = & 
 ll_LeftPos + iw_parentwindow.workspacewidth() + & 
 ii_borderwidth - (ii_winmaxwidth + 12 + li_xpos_extra)
 ll_frame_xpos = ll_LeftPos  + (2*ii_borderwidth) + 16
 if ll_desiredstatubar_xpos < ll_frame_xpos then 
  // Status Bar would extend to the left of the frame.
  this.move(ll_frame_xpos , ll_bottompos - 70)
  // Make the StatuBar the width of the frame.
  this.width = iw_parentwindow.workspacewidth() - (20 +
 li_xpos_extra)
 else 
  // Normal as large as defined Status Bar window.
  this.move(ll_desiredstatubar_xpos , ll_bottompos -
 70)
  this.width = ii_winmaxwidth
 end if
end if

MDI frames Resize Service Need modification. Refer to the detailed information below.

Step 1: Change the wintype property for the w_examplemain
object from MDI to main.

Step 2: Modify the pfc_open event in the
n_exampleappmanager of the appexmfe.pbl as shown below:

Current scripts in PFC:

Open ( w_examplemain)
Appeon compliant scripts in PFC
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Object Suggestion
Open ( w_frame)
opensheet(w_examplemain, w_frame, 0, layered!)

Step 3: Copy the following scripts from the pfc_preopen event
for the w_examplemain object in the appexmfe.pbl to the
pfc_preopen event for the w_frame object in the exmmain.pbl
and then comment out the following scripts in this event.

// Set the frame window with the application manager.
gnv_app.of_SetFrame(w_examplemain)
gnv_app.of_SetMicrohelp(true)
// Enable the Status Bar Services
of_SetStatusBar(true)
if IsValid(inv_statusbar) then
 inv_statusbar.of_SetBorderType(0)
 inv_statusbar.of_SetGapWidth(40)
 inv_statusbar.of_Register ('debugsrv', 'bitmap',
 'dbsvc.gif', 80)
 inv_statusbar.of_Register ('sqlspysrv', 'bitmap',
 'sssvcoff.gif', 80)
 inv_statusbar.of_Register ('debuglogwin', 'bitmap',
 'dlgwnoff.gif', 80)
 inv_statusbar.of_Register ('sqlspywin', 'bitmap',
 'sswinoff.gif', 80)
 if gnv_app.ienv_object.Win16 then
  inv_statusbar.of_SetGDI(true)
  inv_statusbar.of_SetUser(true)
  end if
 inv_statusbar.of_SetTimer(true)
end if

Any ClassName Need modification. Refer to the detailed information below.

DETAILED INFORMATION

Location: Of_updatespending(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: If ClassName(la_rc) = 'integer' or
ClassName(la_rc)='long' Then

Line Number: 133

Change the code to:

if AppeonGetClientType( ) = 'PB' then
 If ClassName(la_rc) = 'integer' or ClassName(la_rc) =
 'long' Then
 // Functionality was found.
 If la_rc < 0 Then Return -1
  If la_rc >= 1 Then
  lb_updatespending = True
  If TypeOf (lpo_tocheck) = DataWindow! Then
  la_rc = lpo_tocheck.Function Dynamic of_IsRoot()
  If ClassName(la_rc) = 'boolean' Then
   lb_updatespending = la_rc
  Else
  Return -1
  End If
  End If
 End If
  lb_performedtest = True
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   End If
  else
  If ClassName(la_rc) = 'integer' or ClassName(la_rc) =
 'long' or ClassName(la_rc) = 'number' Then
  If la_rc < 0 Then Return -1
     If la_rc >= 1 Then
       lb_updatespending = True
   If TypeOf (lpo_tocheck) = DataWindow! Then
   la_rc = lpo_tocheck.Dynamic of_IsRoot()
    If ClassName(la_rc) = 'boolean' then
     lb_updatespending = la_rc
    else
    Return -1
    End if
   End If
  End If
  lb_performedtest = True
 End If
end if
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8 Migration Tutorial

8.1 Introduction

This tutorial is a series of five exercises in which you convert and deploy the Appeon tutorial
PowerBuilder application to the Web. By following the tutorial, you will get hands-on
experience in Web migration using Appeon for PowerBuilder.

The Appeon tutorial PowerBuilder application is a small program involving database
interaction. The application is used in the tutorial as the target PowerBuilder application to be
worked on for a complete Web migration.

This tutorial is a simplified and practical example of the Appeon Web migration
methodology laid out in Chapter 3, Migration Process. It can serve as a starting point for any
developer who wants to convert their existing PowerBuilder applications. After the successful
migration of the tutorial application, you can try to convert more complex, real PowerBuilder
applications into a more complicated network environment.

How you will proceed:

Lesson 1 Load the Appeon tutorial application into PowerBuilder.

Lesson 2 Configure Appeon Developer.

Lesson 3 Analyze the tutorial application for unsupported features.

Lesson 4 Deploy the tutorial application to the Web.

Lesson 5 Run the Web application.

What you will learn:

Lesson 1 How to create a PowerBuilder workspace, load application PBL files, set up an
ODBC data source, and run the application from the PowerBuilder IDE.

Lesson 2 Add the application profile, the Appeon Server profile, the Web server profile,
the deployment profile, the data source profile, and the transaction object
mapping in the Appeon Developer Configuration Wizard.

Lesson 3 Perform unsupported feature analysis, perform a Full build, and optimize the
tutorial application.

Lesson 4 Deploy the tutorial application to the Web using the Appeon Deployment
Wizard.

Lesson 5 Run the deployed Web application in the Web browser.

How long it will take:

You can complete the entire tutorial in ninety minutes. Each lesson has also been designed so
that you can stop after any lesson and continue at another time.

8.1.1 Preparing for the tutorial

The following preparations are required before starting this tutorial:
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• Set up one Workstation.

This tutorial assumes the most simplified network environment. Only one physical
machine is used for all the different roles in the n-Tier Web architecture: Client PC, Web
Server, Application Server, Database Server, and Developer PC.

Refer to Installation Guide for .NET for specific system requirements.

• Install other required softwares:

Windows Server 2008 SP2, Windows Server 2008 R2, Windows Server 2012, Windows 7,
or Windows 8/8.1

SAP Sybase PowerBuilder 9.0, 10.2, 10.5, 11.2, 11.5, 12.0, 12.5, or 12.6

Internet Explorer 8.0 or later, Google Chrome, Mozilla FireFox, or Opera.

Microsoft .NET Framework 4.x & IIS 6.0, 7.0, 7.5, or 8.0

Note:

1. IIS is included with Windows, but not installed by default, you will need to install IIS
first.

2. IIS will be used as both the application server and the Web server in this tutorial.

3. If Appeon Server is installed to the other application servers (such as WebLogic,
WebSphere, JBoss, or JEUS), you can still follow the steps in this tutorial for
configuring and deploying the Appeon tutorial application while paying close attention
to the parts specified as working differently for different application servers.

• Install Appeon for PowerBuilder (on .NET) edition

Install Appeon Server and Appeon Developer components. The demo application that the
tutorial uses will be automatically installed during the Appeon Developer installation.

If you intend to install Appeon Server and Appeon Developer on different machines, most of
the instructions in this tutorial, with the exception of some settings associated with Appeon
Server, such as Appeon Server profile and data sources, will still be relevant. For instructions,
refer to the Appeon Developer User Guide.

8.1.2 Relevant files

The tutorial will use the following files:

File Name appeontutor.pbl appeontutor.db

Location \appeondemo\Tutorial

(e.g. C:\Users\Public\Documents\Appeon\Developer2015\AppeonDemo
\Tutorial)

Description The PowerBuilder Library
(application source code) used in
the tutorial.

The Sybase ASA/SQL Anywhere
database file used for the tutorial
application.
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8.2 Loading the Tutorial PowerBuilder Application

This tutorial starts with two files: appeontutor.pbl and appeontutor.db. The appeontutor.pbl
file contains the source code for the Appeon tutorial PowerBuilder application. First, follow
the instructions to make the tutorial application run in PowerBuilder.

In this section, you will learn how to:

• Create a new PowerBuilder Workspace

• Load the tutorial PBLs into the Workspace

• Configure the ODBC data source for the tutorial application

• Run the tutorial application

8.2.1 Creating a Workspace

You can have only one PowerBuilder Workspace open at a time, but you can add as many
targets or applications to the Workspace as you want, including opening and editing objects
in multiple targets.

To create a new Workspace for the Appeon tutorial PowerBuilder application:

Step 1: Start PowerBuilder. The PowerBuilder IDE starts with the Appeon Developer toolbar
loaded.

Figure 8.1: Appeon Developer tool bar loaded into PowerBuilder

Step 2: Select File > New from the PowerBuilder menu bar, and the New dialog box appears.
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Figure 8.2: Adding a new Workspace

Step 3: Select the Workspace icon in the Workspace tab and click OK.
The New Workspace dialog box displays. Navigate to the %Appeon%
\Developer2015\appeondemo\Tutorial folder, for example, C:\Users\Public\Documents
\Appeon\Developer2015\AppeonDemo\Tutorial.

Type appeontutor in the File name text box and click Save.

Figure 8.3: Naming the new Workspace

The appeontutor workspace has been added and appears as the top item in the PowerBuilder
system tree.
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Figure 8.4: Newly created Workspace

8.2.2 Loading the tutorial PBL file

A PowerBuilder Library (*.pbl file) is a collection of compiled object definitions and source
objects (including scripts) stored in the same location. The PowerBuilder painters and
wizards store various objects in libraries, such as Applications, Windows, DataWindows,
Menus, Functions, Structures, and User Objects.

Now load the PBL file of the Appeon tutorial application into the newly created Workspace:

Step 1: Select File > New from PowerBuilder menu bar, and the New dialog box appears.

Click the Target tab if it is not already selected.
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Figure 8.5: Target tab

Step 2: Select the Existing Application icon and click OK. Now the Choose Library and
Application dialog box is displayed.

Select the appeontutor application under the appeontutor.pbl, and click Next.

Figure 8.6: Choose Library and Application
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Step 3: Click Next in the Set Library Search Path dialog box.

Figure 8.7: Set Library Search Path

Step 4: Click Finish in the Specify Target File dialog box.

Figure 8.8: Specify Target File

Step 5: The Appeon tutorial PowerBuilder application has now been added to the
appeontutor Workspace and is displayed in the system tree.
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Figure 8.9: Newly added "appeontutor" Workspace

8.2.3 Configuring ODBC data source

An ODBC data source stores the parameters used to connect to the indicated data provider
through the Open Database Connectivity interface. By setting up the ODBC data source
that identifies the Sybase ASA/SQL Anywhere database file for the Appeon tutorial
PowerBuilder application, the tutorial application is able to establish a connection with the
Sybase ASA/SQL Anywhere database through a reference to the ODBC data source name.

To set up the ODBC data source for the tutorial application:

Step 1: Select Tools > Database Profile from the PowerBuilder menu bar, and the Database
Profiles dialog box displays.
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Figure 8.10: Database Profiles

Step 2: Choose ODB ODBC > Utilities, and then double click ODBC Administrator.

Figure 8.11: Database Profiles

Step 3: Select the System DSN tab in the ODBC Data Source Administrator dialog box
and click Add.
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Figure 8.12: ODBC Data Source Administrator

Step 4: Select the SQL Anywhere 10 driver to connect to the appeontutor.db database file.
Select SQLAnywhere 10 and click Finish in the Create New Data Source dialog box.

Figure 8.13: Create a Data Source

Step 5: The ODBC Configuration for SQL Anywhere dialog box is displayed. Type the
necessary settings into the different tabs as specified in the following table, and leave other
fields at their default settings.
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Table 8.1: Data source settings

In this tab... In this field... You should...

ODBC Data source
name

Type appeontutor

User ID Type dba (case sensitive)Login

Password Type sql (case sensitive)

Server name Type appeontutor

Database name Type appeontutor

Database

Database file Click Browse to select the AppeonSample.db
file. For example, C:\Users\Public\Documents
\Appeon\Developer2015\appeondemo\Database
\AppeonSample.db.

Figure 8.14: ODBC tab
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Figure 8.15: Login tab

Figure 8.16: Database tab

Step 6: Go back to the ODBC tab and click Test Connection. Ensure the connection test is
successful before continuing.
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Step 7: Click OK to close the ODBC Configuration for SQL Anywhere dialog box.

The appeontutor is added as a system data source under the System DSN tab.

Step 8: Click OK to close the dialog box and click Close to exit the Database Profiles dialog
box.

Figure 8.17: ODBC Data Source Administrator

8.2.4 Running the tutorial application

The database connection parameters (PowerBuilder Transaction properties) have been
preset in the tutorial PowerBuilder application that will connect to the data source named
appeontutor. You can run the tutorial application in PowerBuilder now.

To run the Appeon tutorial PowerBuilder application:

Step 1: In the PowerBuilder IDE, choose Run > Run appeontutor from the PowerBuilder
menu bar, or click the Run icon in PowerBar1. The Appeon tutorial PowerBuilder
application starts.
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Figure 8.18: Appeon Tutorial Application

Step 2: In the Appeon Tutorial Application, select File > Drag and Drop to open the Drag
and Drop window.

The Appeon tutorial PowerBuilder application has an MDI window, two sheet windows, and
an About window. In the Drag and Drop window, click the Retrieve button to display data.
Click a row in the DataWindow and hold down the right mouse button to drag and drop the
full name in the row into the right ListBox. Click the Clear button to reset the ListBox.
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Figure 8.19: Drag and Drop

Step 3: Select File > Randomize to open the Randomize a number window.

This window uses the PowerBuilder Randomize and Rand functions to randomly generate an
integer between 1 and 10, and display it in a window.
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Figure 8.20: Randomize a number

Step 4: Close the tutorial application, and return to the PowerBuilder IDE.

8.3 Configuring Appeon Developer

Appeon Developer, a component of Appeon for PowerBuilder, extends the capabilities of
PowerBuilder, allowing a new or existing PowerBuilder application to be converted into a
bona fide Web Application, using only PowerBuilder skills.

Appeon Developer provides a set of tools that enable the entire PowerBuilder-to-Web
process to take place within the PowerBuilder IDE. These tools are accessed via a toolbar
in the PowerBuilder IDE. The Appeon Developer toolbar automatically loads each time
PowerBuilder is opened.

Figure 8.21: Appeon Developer toolbar

The Appeon tutorial PowerBuilder application should run through the following
configuration tasks before Appeon Developer can automate the task of Web conversion and
deployment of the tutorial application.

• Configuring basic settings
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• Selecting PBL file(s)

• Configuring deployment settings

• Selecting DB Type(s)

• Declaring transaction object(s)

All these configuration tasks can be completed within the Appeon Developer Configuration

Wizard. To access this wizard, click the Config Wizard button ( ) on the Appeon
Developer toolbar.

Read the requirements on the Welcome screen and click Next to proceed.

Figure 8.22: Welcome page

8.3.1 Configuring basic settings

The basic settings refers to the settings of an application that are essential for deployment,
including the application profile name, Web folder, and project type.
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Figure 8.23: Configure basic settings window

Step 1: Specify the settings as follows:

• In the Application Profile Name field, input appeontutor.

• In the Web Folder field, input appeontutor (This field is automatically filled with what
you enter in the Application Profile Name field, so you may just need to check it.).

• Select Web from the Project Type dropdown list box.

Step 2: Click Next to proceed.

8.3.2 Selecting PBL file(s)

Specify the version and the location of source code of the PowerBuilder application.



Migration Tutorial Appeon® for PowerBuilder® 2015

Migration Guidelines for Appeon Web (Web only) Page 69

Figure 8.24: Select PBLs

Step 1: Verify that appeontutor.pbt is currently selected in the PBT field. Or click the browse
(...) button to select the appeontutor.pbt file.

When the appeontutor.pbt file is selected, the appeontutor PBL file is automatically added to
the PBL File List.

Step 2: Check the Keep PBT Updated checkbox.

Step 3: Choose a PowerBuilder version from the PBL Version dropdown list box.

Step 4: Click Next to proceed.

8.3.3 Configuring deployment settings

The deployment settings associate the Appeon Server(s) and Web server(s) as a group used
for application deployment. In this tutorial, the deployment profile will associate Appeon
Server Tutor and Web Server Tutor.

In this section, you will learn:

• Starting Appeon Server and Web server

• Adding an Appeon Server profile

• Adding a Web server profile

• Selecting a deployment profile
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8.3.3.1 Starting Appeon Server and Web server

When adding the Appeon Server profile and Web server profile, you need to verify the
connection to the Appeon Server and the Web server; therefore, you should start them
before configuration. If you want to start Appeon Server installed to EAServer, WebLogic,
WebSphere, JBoss, or JEUS, refer to Installation Guide for .NET for detailed instructions. In
this tutorial, IIS will be used as both the Appeon Server and the Web server. Therefore, you
only need to start IIS. Refer to the following steps for how to start the IIS/Appeon Server.

Select Windows Start > Programs > Appeon for PowerBuilder 2015 > Appeon Server
for .NET > IIS Manager.

Make sure that the Web Site where Appeon Server is installed is started, as shown in the
following figure. If not, please select the name listed on the Web Site page and click Start on
the Actions pane to start it. If it is started, the Start menu will be grayed out. The following
figure indicates that Appeon Server and Web server are ready for use.

Figure 8.25: IIS/Appeon Server

8.3.3.2 Adding an Appeon Server profile

Each Appeon Server profile contains settings of an Appeon Server/application server used by
the Appeon deployment.
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Figure 8.26: Appeon Server profile

To add the Appeon Server profile for the deployment of the tutorial application:

Step 1: Click the Add button in the Appeon Servers group box.

The Appeon Server Profile Configuration dialog box appears.
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Figure 8.27: Appeon Server Profile Configuration

The following table lists instructions for how to specify the properties for an Appeon Server
profile.

Table 8.2: Instructions for creating an Appeon Server profile

Property Instructions

Profile Name Input "AppeonServerTutor" as the name of the Appeon Server
profile.

Server Input "localhost".

To deploy to a remote Appeon Server, enter the IP address or
machine name of the remote server.

Server Type Make sure that .NET is selected.

If Appeon Server is installed to EAServer, WebLogic, WebSphere,
JBoss, or JEUS, then select "J2EE".

Server Port (http) Input "80".

If Appeon Server is installed to EAServer, input "9988"; if installed
to WebLogic, input "7001"; if installed to WebSphere, input "9080";
if installed to JEUS, input "8088"; if installed to JBoss, input "8080".

To deploy to a remote Appeon Server, enter the HTTP port of the
remote server.

AEM URL The URL for Appeon Enterprise Manager (AEM) will be
automatically generated after Server and Server Port are specified.
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Property Instructions

Connection method Leave it as default.

Deployment Security Leave it as default.

Username Leave it as default.

Password Leave it as default.

Step 2: Click Test Appeon Server Settings.

Appeon Developer will try to connect to Appeon Server with the parameters you specified.
Make sure the test is successful before you continue.

Figure 8.28: Test connection

Step 3: Click OK.

Appeon Server Tutor is added to the Appeon Servers list.

Figure 8.29: Appeon Server Tutor is added
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8.3.3.3 Adding a Web server profile

Each Web server profile contains settings of a Web server used by the Appeon deployment.

Since IIS will be used for the deployment of the Appeon tutorial PowerBuilder application,
you need not to start it because IIS/Appeon Server is already running.

To add the Web server profile for the deployment of the tutorial application:

Step 1: Click the Add button in the Web Servers group box.

The Web Server Profile Configuration dialog box appears.

Figure 8.30: Web Server Profile Configuration window

The following table lists instructions for how to specify the properties for a Web server
profile.

Table 8.3: Instructions for creating a Web Server profile

Property Instructions

Profile Name Input "Web Server Tutor" as the name of the Web Server profile.

File Transfer Type Select Local Server.

To deploy to a remote Web Server, select Remote Server, and then
specify the FTP Port, FTP Username and FTP Password of the remote
server.

HTTP Server Input "localhost".
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Property Instructions
To deploy to a remote Web Server, enter the IP address or machine
name of the remote server.

Server Type Select Microsoft IIS.

If using EAServer HTTP server, then select EAServer; if using
WebLogic HTTP server, select WebLogic; if using WebSphere HTTP
server, select WebSphere; if using JEUS HTTP server, select JEUS; if
using JBoss HTTP server, select JBoss.

HTTP Port Input "80".

If Appeon Server is installed to EAServer, then Input "9988"; if
installed to WebLogic, then input "7001"; if installed to WebSphere,
then input "9080"; if installed to JEUS, then input "8088"; if installed
to JBoss, then input "8080".

To deploy to a remote Web Server, enter the HTTP port of the remote
server.

Web Root Path Click Browse to navigate to the path to the IIS Web site home
directory (for example: C:\Inetpub\wwwroot).

Step 2: Click Test Web Server Settings.

Appeon Developer will try to connect to the Web server with the IP (localhost) and port (80).
Make sure the test is successful before you continue.

Step 3: Click OK.

Web Server Tutor is added to the Web Servers list.
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Figure 8.31: Web Server Tutor is added

8.3.3.4 Selecting a deployment profile

A deployment profile associates Appeon Server(s) and Web server(s) as a group used for
Web deployment.

Step 1: In the Deployment Profile Name list box, select Local Deployment.

If no deployment profile is available, create one by following instructions in the Appeon
Developer User Guide.

Step 2: Select Appeon Server Tutor in the Appeon Servers list and select Web Server Tutor in
the Web Servers list.

Step 3: Click Next to proceed.
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Figure 8.32: Deployment Profile

8.3.4 Selecting DB Type(s)

Select the database type used by the application. In this tutorial, the database type is Sybase
ASA | UltraLite. Select the Used column of Sybase ASA | UltraLite.
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Figure 8.33: DB Type

If Sybase ASA | UltraLite is not configured (The Configured column is "No"), you should
select it and click the Edit button to create a profile for it. The Database Type Profile
Configuration window will be displayed.
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Figure 8.34: Database Type Profile Configuration window

Step 1: Select the Outer Join Syntax that PowerBuilder will format from the drop-down list
for Database in the Database Type Profile Configuration window.

Step 2: Specify the following settings for ODBC interface in the Database Type Profile
Configuration window.

Table 8.4: Database type profile settings

In this field You should

ODBC Interface Choose the ODBC Interface radio button.

Data Source Choose appeontutor from the dropdown list.

If appeontutor is not available, please choose the Appeon demo database
(appeonsampleforserver or appeonsample2forserver), or any other Sybase
SQL Anywhere data source.

User ID Leave this field blank.

Password Leave this field blank.

Step 3: Click Test to verify that the connection is successful.
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Figure 8.35: Test successful

Step 4: Click OK.

8.3.5 Declaring transaction object(s)

When the tutorial PowerBuilder application is deployed to the Web, Appeon Server handles
the database connection using data sources rather than transaction objects defined in the
PowerBuilder application. You must associate the transaction objects used by the Appeon
tutorial PowerBuilder application with proper data sources.

Figure 8.36: Transaction object mappings

The Appeon tutorial application uses the SQLCA transaction object which connects to the
appeontutor database. To associate the SQLCA transaction object with the proper data
source:

Step 1: Click Add. The Add Transaction Object dialog box is displayed.
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Figure 8.37: Add transaction object mappings

Step 2: Select Sybase ASA / UltraLite from the Database Type dropdown listbox.

Step 3: Select Appeon Server Tutor from the Appeon Server list. The existing data sources
in Appeon Server will be displayed.

Note: the data source tool is available for Microsoft .NET Framework, and not available for
EAServer, WebLogic, WebSphere, JBoss, or JEUS. You should go to the corresponding
application server administration console to configure the data source for EAServer,
WebLogic, WebSphere, JBoss, or JEUS. For detailed instructions, refer to Chapter 4,
Database Connection Setup in Appeon Server Configuration Guide for J2EE.



Migration Tutorial Appeon® for PowerBuilder® 2015

Migration Guidelines for Appeon Web (Web only) Page 82

Figure 8.38: Data sources in the Appeon Server

The following steps show you how to create a data source that links to the appeontutor
ODBC data source using the ODBC driver.

Step 4: Click Add to create a data source. The Add dialog box is displayed.
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Figure 8.39: Add a data source

The following table provides instructions for how to specify the data source settings.

Table 8.5: Instructions to specify data source settings

Settings Instructions

Name Input "appeontutor" as the name of the data source.

Driver Select "ODBC Driver" as the driver type for the data source .

ODBC Data Source Select "appeontutor" as the data source name.

This will connect to the appeontutor ODBC data source that was
created in Section 8.2.3, “Configuring ODBC data source”.

If the database type is Sybase ASA/SQL Anywhere and the database
file resides in an NTFS folder, please grant the "NETWORK
SERVICE" or "Everyone" user with full controls over that folder.
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Settings Instructions

User Name Type "dba".

Password Type "sql".

Step 5: Click Test to verify the connection to the appeontutor data source.

Step 6: Click OK to close the Add dialog box.

The appeontutor data source has been added.

Step 7: Select the Selected button of the appeontutor data source.

Figure 8.40: appeontutor is added

Step 8: Click OK to close the Add Transaction Object dialog box.

The "sqlca" transaction object is added.
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Figure 8.41: sqlca is added

Step 9: Click Next through the rest of settings, until you get to the Summary page.
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Figure 8.42: Summary

Step 10: Click Finish on the Summary page to close the wizard.

The Appeon tutorial application is successfully configured.

The Appeon Deployment Wizard will be launched, if you keep the "Deploy the application
now" option on the Summary page as selected. Refer to Section 8.5, “Deploying the Tutorial
PowerBuilder Application” for how to use it.

8.4 Analyzing Unsupported Features
This chapter shows you how to use the UFA tool to analyze the Appeon tutorial
PowerBuilder application for unsupported features and optimize and full build the tutorial
application.

In this chapter, you will learn how to:

• Perform unsupported feature analysis on the tutorial application

• Optimize and full build the tutorial application

8.4.1 Unsupported features analysis

Appeon provides an unsupported feature analysis (UFA) tool to handle the Appeon
unsupported source code in a PowerBuilder application.

To perform Unsupported Features Analysis to the tutorial application, perform the following
steps:
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Step 1: In the PowerBuilder IDE, click the Analyze button (  or ) on the Appeon
Developer toolbar. The Unsupported Feature Analysis Report window (UFA Report window)
appears.

Figure 8.43: UFA Report window

Step 2: Select the File > New Report menu in the UFA Report window. The New UFA
Report dialog box will appear.
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Figure 8.44: New UFA Report dialog box

Step 3: Click the OK button to analyze the entire application.

The Unsupported Features Analysis Status dialog box is displayed. This shows the progress
of the Unsupported Features Analysis.

Figure 8.45: Unsupported Features Analysis Process dialog
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After the feature analysis is completed, click the Close button and the UFA Report is loaded
into the UFA Report Window. You can view the analysis result in the left treeview and
modify the unsupported features by following the instructions in the Chapter 4, Workarounds
for Unsupported Features in Workarounds & API Guide, which is also available at http://
www.appeon.com/support/documents/appeon_online_help/workarounds_and_api_guide/.
The Guide provides examples of some common unsupported features and ways to work
around them.

In this tutorial, the application contains no unsupported features.

Figure 8.46: UFA Report window

8.4.2 Optimizing and full build

Before any PowerBuilder application is converted by Appeon, ensure the PBLs have been
optimized. You must also "full build" the PowerBuilder application successfully before
Appeon will be able to convert it.

To optimize and full build the tutorial application:

Step 1: Right click on appeontutor.pbl in the PowerBuilder system tree. Click Optimize.

http://www.appeon.com/support/documents/appeon_online_help/workarounds_and_api_guide/
http://www.appeon.com/support/documents/appeon_online_help/workarounds_and_api_guide/
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Figure 8.47: Optimize

Step 2: Right click on the appeontutor Target in the system tree and select Full Build from
the context menu.
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Figure 8.48: Full Build

Step 3: The full build process begins. Some information is displayed in the Output window.
Make sure that when the full build is complete, no error messages occur in the Output
window.

Figure 8.49: Finished Full Build of target appeontutor
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8.5 Deploying the Tutorial PowerBuilder Application

In the previous lessons, the Appeon tutorial PowerBuilder application has undergone careful
analysis for unsupported features. Now you will launch the Appeon Deployment Wizard to
convert the tutorial application onto the Web automatically.

To deploy the tutorial application onto the Web automatically:

Step 1: Make sure Appeon Server is started. For details, refer to Section 8.3.3.1, “Starting
Appeon Server and Web server”.

Step 2: Within the PowerBuilder IDE, click the Deploy button ( ) in the Appeon Developer
toolbar. The Appeon Deployment Wizard starts.

Figure 8.50: Appeon Deployment Wizard

The start page of the Wizard displays the following information:

• Application to be deployed - The current application (appeontutor) is selected by default
from the list of applications that are defined in Appeon Developer application profiles.

• Deployment profile - Make sure the deployment profile, Local Deployment, is selected.

• Deployment mode - Since it is the first time the tutorial application will be deployed,
the Full Application Deployment mode will be selected by default. For subsequent
deployments, the Incremental Application Deployment will be selected by default.

• Unattended Deployment - Check this option so that the entire deployment process is
automatic.

Step 3: Click Next to start the automatic Web deployment process. The Appeon Deployment
Wizard will perform three tasks:
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1. PowerBuilder application source code export and analysis (Task 1: Application Source
Code Export).

2. Parsing of the PowerBuilder source code (PBL files) into Web application files that are
stored on the local machine (Task 2: Appeon Application File Generation).

3. Transfer of local Web files to the Web Server by using either file copy or FTP, and
uploads DataWindows to the Appeon Server (Task 3: Appeon Application Deployment).

When the deployment process is complete, the report dialog box is displayed.

Step 4: Click Finish.

Figure 8.51: Appeon Deployment Wizard

8.6 Running the Web Application
The Appeon tutorial PowerBuilder application has been converted into a standard Web
application with proper database connection which can now be run.

To launch the Web application after the tutorial application has been converted:

Step 1: Make sure Appeon Server is running.

Step 2: Click the Run button ( ) in the Appeon Developer toolbar and select the
appeontutor application in the popup window, or manually open a browser window and type
http://localhost/appeontutor/ into the Address bar and press Enter.

The Web application starts.
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Figure 8.52: Application starts

Click OK to run the Web application now.

Figure 8.53: Application starts
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Step 3: Open the Drag and Drop window.

Figure 8.54: Drag and Drop

Step 4: Open the Randomize a number Window.
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Figure 8.55: Randomize a number Window
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